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1
Introduction

This Agilent VISA User s Guide describes the Agilent Virtual Instrument
Software Architecture (VISA) library and shows how to use it to
develop I/O applications and instrument drivers on Windows PCs.

Before you can use VISA, you must install and configure VISA on your
computer. See the Agilent 10 Libraries Suite Connectivity Guide with
10 Libraries Getting Started for installation on Windows systems.

Note that using VISA functions and SICL functions in the same I/O
application is not supported.

This chapter includes:

e What’s In This Guide?
¢ VISA Overview

* Contacting Agilent

Agilent Technologies 7



1 Introduction

What’s in This Guide?

This guide shows VISA programming techniques using C/C++ and
Visual Basic. This chapter provides an overview of VISA and shows
how to contact Agilent Technologies. Subsequent chapters in this guide
address the following topics:

Chapter 2 - Building a VISA Application in Windows describes how
to build a VISA application in a Windows environment. A sample
program is provided to help you get started programming with VISA.

Chapter 3 - Programming with VISA describes the basics of VISA
and lists some sample programs. The chapter also includes
information on creating sessions, using formatted I/O, events, etc.

Chapter 4 - Programming via GPIB and VXI provides guidelines for
using VISA to communicate over the GPIB, GPIB-VXI, and VXI
interfaces to instruments.

Chapter 5 - Programming via LAN provides guidelines for using
VISA to communicate over a LAN (Local Area Network) to
instruments.

Chapter 6 - Programming via USB provides guidelines for using
VISA to communicate over a USB (Universal Serial Bus) to
instruments.

Glossary includes a glossary of terms and their definitions.

See “VISA Documentation" on page 10 for other sources of information
on VISA programming.

Agilent VISA User’s Guide



VISA Overview

Introduction 1

VISA is an application programming interface (API) for instrument
control. It allows you to programmatically send commands and receive
data from instruments and other test and measurement devices (such as
sources and switches).

VISA is a part of the Agilent IO Libraries Suite product. The Agilent IO
Libraries Suite includes three libraries: Agilent Virtual Instrument
Software Architecture (VISA), VISA for the Common Object Model
(VISA COM), and Agilent Standard Instrument Control Library (SICL).
This guide describes Agilent VISA for supported Windows
environments.

For information on VISA COM, see the online Help on VISA COM,
available by clicking the blue IO Control icon on your screen (if you
have installed Agilent IO Libraries Suite). For information on using
SICL in Windows, see the Agilent SICL Users Guide for Windows. For
information on Agilent IO Libraries Suite, see the Agilent IO Libraries
Suite Connectivity Guide with 10 Libraries Getting Started and the
Agilent 10 Libraries Suite Online Help.

Using VISA, VISA COM, and SICL

Agilent VISA User’s Guide

Agilent Virtual Instrument Software Architecture (VISA) is an I[/O
library designed according to the VXIplug&play System Alliance that
allows software developed from different vendors to run on the same
system.

If you are using new instruments or are developing new I/O applications
or instrument drivers, and you have chosen to use direct I/O rather than
instrument drivers, we recommend you use Agilent VISA or VISA
COM. See the Agilent 10 Libraries Suite Online Help for an in-depth
discussion of your programming options.

Agilent Standard Instrument Control Library (SICL) is an I/O library
developed by Agilent that is portable across many I/O interfaces and
systems. You can use Agilent SICL if you have been using SICL and
want to remain compatible with software currently implemented in
SICL.
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Introduction

VISA Support

This 32-bit version of VISA is supported on Microsoft Windows 2000
and Windows XP. (For information on support of older operating
systems, see the Agilent 10 Libraries Suite Online Help.) C, C++, and
Visual Basic are supported on these Windows versions. C# and Visual
Basic .NET are also supported via the visa32.cs and visa32.vb
header files that are included with the Agilent VISA library.

VISA is supported on the GPIB, VXI, GPIB-VXI, Serial (RS-232),
LAN, and USB interfaces. LAN support from within VISA occurs via
an address translation such that a GPIB interface can be accessed
remotely over a computer network.

Agilent VISA provides support for version 3.0 of the VISA specifica-
tion.

VISA Documentation

This table shows associated documentation you can use when
programming with Agilent VISA.

Table 1  Agilent VISA Documentation

Document Description

Agilent 10 Libraries Suite Shows how to install, configure, and

Connectivity Guide with 10 maintain Agilent IO Libraries Suite.

Libraries Getting Started

VISA Online Help A function reference and other
programming information is provided in
the form of Windows Help.

VISA Sample Programs Sample programs are provided online to

help you develop VISA applications.

VXiplug&play System Alliance Specifications for VISA.
VISA Library Specification 4.3

IEEE Standard Codes, Formats, = ANSI/IEEE Standard 488.2-1992.
Protocols, and Common
Commands

Agilent VISA User’s Guide
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Introduction 1
Table1 Agilent VISA Documentation
VXIbus Consortium TCP/IP Instrument Protocol
specifications (when using VISA  Specification - VXI-11, Rev. 1.0
over LAN) TCP/IP-VXIbus Interface Specification -

VXI-11.1, Rev. 1.0

TCP/IP-IEEE 488.1 Interface
Specification - VXI-11.2, Rev. 1.0
TCP/IP-IEEE 488.2 Instrument Interface
Specification - VXI-11.3, Rev. 1.0
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1 Introduction

Contacting Agilent

12

In the USA, you can reach Agilent Technologies by telephone at:

USA: 1-800-829-4444
Outside the USA, contact your country’s Agilent support

organization. A list of contact information for other countries is
available on the Agilent Web site:
http://www.agilent.com/find/assist

The Agilent Developer Network (ADN),

http://www.agilent.com/find/adn

is a one-stop web resource that supports your connectivity needs with
software downloads, sample code, technical notes and white papers.

Agilent VISA User’s Guide
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2
Building a VISA Application in
Windows

This chapter provides guidelines for building a VISA application in a
Windows environment.

The chapter contains the following sections:
¢ Building a VISA Program (C/C++)

¢ Building a VISA Program (Visual Basic)
* Logging Error Messages

For information on building a VISA application in Visual Studio .NET,
see the VISA Online Help.

i Agilent Technologies 13




2

Building a VISA Application in Windows

Building a VISA Program (C/C++)

14

This section provides guidelines for building VISA programs using the
C/C++ language, including:

Compiling and Linking VISA Programs (C/C++)
Sample VISA Program (C/C++)

Compiling and Linking VISA Programs (C/C++)

This section provides a summary of important compiler-specific
considerations when developing Win32 applications.

Linking to VISA Libraries

Your application must link to the VISA import library as follows,
assuming default installation directories and Microsoft compilers:

C:\Program Files\VISA\winnt\lib\msc\visa32.1ib

The following steps will help you do this. This information is specific to
your development environment.

Microsoft Visual C++ Version 6.0 Development Environment

1

Use the File menu to create a new project or open an existing project.

2 Select Project > Settings from the menu and click the C/C++ tab.

Select Code Generation from the Category list box and select
Multi-Threaded using DLL from the Use Run-Time Libraries list
box. (VISA requires these definitions for Win32.) Click OK to close
the dialog box.

Select Project > Settings from the menu. Click the Link tab and add
visa32.1ib to the Object/Library Modules list box. Optionally,
you may add the library directly to your project file. Click OK to
close the dialog box.

You may want to add the include files and library files search paths.
They are set as follows:

Select Tools > Options from the menu.
Click the Directories tab to set the include file path.

Select Include Files from the Show Directories For list box.

Agilent VISA User’s Guide



Building a VISA Application in Windows 2

Click at the bottom of the list box and type:
C:\Program Files\VISA\winnt\include

(This assumes that you used the default installation location for
VISA.)

Select Library Files from the Show Directories For list box.

Click at the bottom of the list box and type:

C:\Program Files\VISA\winnt\lib\msc

(This assumes that you used the default installation location for
VISA))

6 Add or create your C or C++ source files. For example, to build the
sample described below, select Project > Add to Project > Files...
and type or browse to C: \Program Files\Agilent\

IO Libraries Suite\ ProgrammingSamples\C\VISA\
idn.c.

7 Click Build > Rebuild All to build the VISA program.
Microsoft Visual Studio .NET

For information on building a VISA application in Visual Studio .NET,
see the VISA Online Help.

Sample VISA Program (C/C++)

Agilent VISA User’s Guide

This section lists a sample program called idn that queries a GPIB
instrument for its identification string. This sample assumes a Win32
console application using Microsoft Visual Studio® on Windows.

The idn sample files are in the ProgrammingSamples directory
under the Agilent IO Libraries Suite installation directory. By default,
the sample files are in

C:\Program Files\Agilent\IO Libraries Suite\
ProgrammingSamples\C\VISA.

Sample C/C++ Program Source Code

The source file idn . c follows. An explanation of the various function
calls in the sample is provided directly after the program listing. If the
program runs correctly and your PC is connected to a 54622A
oscilloscope, the following is an example of the program output.

AGILENT TECHNOLOGIES,54622A,987654312,A.01.50

15



2 Building a VISA Application in Windows

If the program does not run, see the Event Viewer for a list of run-time
eITOTS.

/*idn.c
This example program queries a GPIB device for
an identification string and prints the
results. Note that you must change the address.

*/

#include <visa.h>
#include <stdio.h>

void main () {

ViSession defaultRM, vi;
char buf [256] = {0};

/* Open session to GPIB device at address 22 */
viOpenDefaultRM (&defaultRM) ;
viOpen (defaultRM,
"GPIB0::22::INSTR",VI NULL,VI NULL,
&vi) ;

/* Initialize device */

viPrintf (vi, "*RST\n");

/* Send an *IDN? string to the device */
viPrintf (vi, "*IDN?\n"):;

/* Read results */

viScanf (vi, "%t", buf);

/* Print results */
printf ("Instrument identification string:
$s\n", buf);

/* Close session */

viClose (vi);
viClose (defaultRM) ; }

16 Agilent VISA User’s Guide
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C/C++ Sample Program Contents

A summary of the VISA function calls used in the preceding sample
C/C++ program follows. For a more detailed explanation of VISA
functionality, see Chapter 3, “Programming with VISA.” See the VIS4
Online Help for more detailed information on these VISA function

calls.

Table 2 Summary of VISA Function Calls Used in the C/C++ Sample

Function(s)

Description

visa.h

ViSession

viOpenDefaultR
M

viOpen

viPrintf and
viScanf

viClose

This file is included at the beginning of the program to
provide the function prototypes and constants defined by
VISA.

The ViSession is a VISA data type. Each object that will
establish a communication channel must be defined as
ViSession.

You must first open a session with the default resource
manager with the viOpenDefaultRM function. This
function will initialize the default resource manager and
return a pointer to that resource manager session.

This function establishes a communication channel with
the device specified. A session identifier that can be used
with other VISA functions is returned. This call must be
made for each device you will be using.

These are the VISA formatted I/O functions that are
patterned after those used in the C programming
language. The viPrintf call sends the IEEE 488.2 *RST
command to the instrument and puts it in a known state.
The viPrintf call is used again to query for the device
identification (*IDN?). The viScanf call is then used to
read the results.

This function must be used to close each session. When
you close a device session, all data structures that had
been allocated for the session will be deallocated. When
you close the default manager session, all sessions opened
using that default manager session will be closed.

17
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Building a VISA Program (Visual Basic)
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This section provides guidelines for building a VISA program in the
Microsoft Visual Basic (VB) language, including:

* Visual Basic Programming Considerations

e Sample VISA Program (Visual Basic)

Visual Basic Programming Considerations

Some considerations for programming in Visual Basic follow. This
information applies to Microsoft Visual Basic version 6.0; for
information on building a VISA application in Microsoft Visual Studio
NET, see the VISA Online Help.

Required Module for a Visual Basic VISA Program

Before you can use VISA specific functions, your application must add
the visa32.bas VISA Visual Basic module found in C: \
Program Files\VISA\winnt\include\ (assuming default
installation directories).

Adding the visa32 .bas File to Your Project

To install visa32.bas:
1 Select Project > Add Module from the Visual Basic 6.0 menu.
2 Select the Existing tab.

3 Browse and select the visa32.bas file from the applicable
directory (by default, C: \Program Files\VISA\winnt\
include\).

4 Click the Open button.

VISA Limitations in Visual Basic

VISA functions return a status code that indicates success or failure of
the function. The only indication of an error is the value of a returned
status code. The VB Error variable is not set by any VISA function.
Thus, you cannot use the ON ERROR construct in VB or the value of
the VB Error variable to catch VISA function errors.

Agilent VISA User’s Guide
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VISA cannot call back to a VB function. Thus, you can only use the
VI_QUEUE mechanism in viEnableEvent. There is no way to
install a VISA event handler in VB.

VISA functions that take a variable number of parameters (viPrint£,
viScanf, viQueryf) are not callable from VB. Use the
corresponding viVPrintf, viVScanf and vivQueryf functions
instead.

You cannot pass variables of type Variant to VISA functions. If you
attempt this, the Visual Basic program will probably crash with a
'General Protection Fault' or an 'Access Violation.'

Format Conversion Commands

The functions viVPrintf, viVscanf and vivVqueryf can be
called from VB, but there are restrictions on the format conversions that
can be used. Only one format conversion command can be specified in a
format string (a format conversion command begins with the %
character).

For example, the following is invalid:

status = viVPrintf (vi, "$1£%d" + Chr$(10),
)

Instead, you must make one call for each format conversion command,
as shown in the following example:

status = viVPrintf(vi, "%1f" + Chr$(10),
dbl value)
status = viVPrintf(vi, "%d" + Chr$(10),
int value)

Numeric Arrays

When reading from or writing to a numeric array, you must specify the
first element of a numeric array as the params parameter. This passes
the address of the first array element to the function. For example, the
following code declares an array of 50 floating point numbers and then
calls viVPrintf£ to write from the array.

Dim flt array(50) As Double
status = viVPrintf (id, "%,50f", dbl array(0))

19



2 Building a VISA Application in Windows

Strings

When reading in a string value with viVScanf£ or vivVQueryf, you
must pass a fixed length string as the params parameter. To declare a
fixed length string, instead of using the normal variable length
declaration:

Dim strVal as String
use the following declaration, where 40 is the fixed length.

Dim strVal as String * 40

Sample VISA Program (Visual Basic)

This section lists a sample program called idn that queries a GPIB
instrument for its identification string. This sample builds a standard
.exe application for WIN32 programs using the Visual Basic 6.0
programming language.

Assuming default installation directories, the idn sample files are in C: \
Program Files\Agilent\IO Libraries Suite\
ProgrammingSamples\VB6\VISA\IDN

Steps to Running the Program

The steps to building and running the idn sample program follow.

1 Connect an instrument to a GPIB interface that is compatible with
IEEE 488.2.

2 Start the Visual Basic 6.0 application.

This example assumes you are building a new project (no . vbp file
exists for the project). If you do not want to build the project from
scratch, from the menu select File > Open Project... and select and
open the idn . vbp file. Then skip to Step 7.

3 Start a new Visual Basic Standard . exe project. VB 6.0 will open a
new project, Projectl, with a blank Form, Form1.

4 From the menu, select Project > Add Module, select the Existing
tab, and browse to the idn directory. If you used default installation
paths, this directory is C: \Program Files\Agilent\IO

20 Agilent VISA User’s Guide
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Libraries Suite\ProgrammingSamples\VB6\VISA\
idn.

5 Select the file idn.bas and click Open. Since the Main()
subroutine is executed when the program is run without requiring
user interaction with a Form, you may delete Form1 if desired. To do
this, right-click Form1 in the Project Explorer window and select
Remove Forml.

6 VISA applications in Visual Basic require the VISA Visual Basic
(VB) declaration file visa32.bas in your VB project. This file
contains the VISA function definitions and constant declarations
needed to make VISA calls from Visual Basic. To add this module to
your project in VB 6.0, from the menu select Project > Add
Module, select the Existing tab, browse to the directory containing
the VB declaration file (by default, this is C: \Program Files\
VISA\winnt\include\), select visa32.bas, and click
Open.

7 At this point, you can run and debug the Visual Basic project. You

may need to change the VISA interface name and address in the code
to match your device’s configuration.

8 Ifyou want to compile to an executable file, from the menu select
File > Make idn.exe... and click OK. This will create idn.exe in
the idn directory.

Sample Program Source Code

An explanation of the various function calls in the sample is provided
after this program listing. If the program runs correctly, the following is
an example of the output that appears in a message box if your PC is
connected to a 54601A oscilloscope.

HEWLETT-PACKARD,54601A,0,1.7

Agilent VISA User’s Guide 21
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If the program does not run, see the Event Viewer for a list of run-time
errors. The source file 1dn.bas follows.

Option Explicit

rryrryryyryryryryryrryrryrryrryrryrryrryrrrrrrrrrrrrrrvrrrrvrurouy

rryrryrryrvrrvrrvrrvrrvrounay

idn.bas

This example program queries a GPIB device for
an identification string and prints the
results. Note that you may have to change the
VISA Interface Name and address for your
device from "GPIBO" and "22",respectively.

rryrryryryryyryryryrryrryrryrryrrrrrrrrrrrrrrrrrrvrrrrvruroung

rryrryrryrvyrrvrrvrrvrruvrounay

Sub Main ()
Dim defrm As Long 'Session to Default
Resource Manager
Dim vi As Long 'Session to instrument

22

Dim strRes As String * 200 'Fixed length
string to hold results

Open the default resource manager session
Call viOpenDefaultRM (defrm)
Open the session to the resource

The "GPIBO" parameter is the VISA Interface
name to a

GPIB instrument as defined in

Connection Expert.

Change this name to what you have defined
for your VISA Interface.

' "GPIB0::22::INSTR" is the address string
for the device.

this address will be the same as seen in:
Connection Expert)

Agilent VISA User’s Guide
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Call viOpen (defrm, "GPIBO::22::INSTR", 0, O,
vi)
]

Initialize device
Call viVPrintf(vi, "*RST" + Chr$(10), 0)

' Ask for the device's *IDN string.
Call viVPrintf (vi, "*IDN?" + Chr$(10), O0)

Read the results as a string.
Call vivVScanf (vi, "%t", strRes)

Display the results
MsgBox "Result is: " + strRes, vbOKOnly,
"*IDN? Result"

Close the vi session and the resource
manager session
Call viClose (vi)
Call viClose (defrm)
End Sub

Sample Program Contents

A summary of the VISA function calls used in the preceding sample
Visual Basic program follows. For a more detailed explanation of VISA
functionality, see Chapter 3, “Programming with VISA. ” See the VIS4
Online Help for more detailed information on these VISA function
calls.

Table3 Summary of VISA Function Calls in Visual Basic Sample

Function(s) Description

viOpenDefaultRM You must first open a session with the default
resource manager with the viOpenDefaultRM
function. This function will initialize the default
resource manager and return a pointer (defim) to that
resource manager session.

23
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Table 3 Summary of VISA Function Calls in Visual Basic Sample

viOpen

viVPrintf and
viVScanf

viClose

This function establishes a communication channel
with the device specified. A session identifier (vi) that
can be used with other VISA functions is returned.
This call must be made for each device you will be
using.

These are the VISA formatted I/O functions. The
viVPrintf call sends the IEEE 488.2 *RST command
to the instrument (plus a linefeed character) and puts
it in a known state. The viVPrintf call is used again
to query for the device identification (*IDN?). The
viVScanf call is then used to read the results (strRes)
that are displayed in a Message Box.

This function must be used to close each session.
When you close a device session, all data structures
that had been allocated for the session will be
deallocated. When you close the default manager
session, all sessions opened using that default
manager session will be closed.

Agilent VISA User’s Guide
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Logging Error Messages

When developing or debugging your VISA application, you may want
to view internal VISA messages while your application is running. You
can do this by using the Event Viewer utility or the Debug Window.
There are three choices for VISA logging:

* Off (default) for best performance

* Event Viewer

* Debug Window

Using the Event Viewer

The Event Viewer utility provides a way to view internal VISA error
messages during application execution. Some of these internal messages
do not represent programming errors; they indicate events which are
being handled internally by VISA. The process for using the Event
Viewer is:

* Enable VISA logging from the Agilent IO Control by clicking the
blue IO icon on the taskbar and then clicking Agilent VISA Options
> VISA Logging > Event Viewer.

* Run your VISA program.

* View VISA error messages by running the Event Viewer. From the
Agilent 10 Control, click Event Viewer. VISA error messages will
appear in the application log of the Event Viewer utility.

Using the Debug Window

When VISA logging is directed to the Debug Window, VISA writes
logging messages using the Win32 API call OutputDebugString(). The
most common use for this feature is when debugging your VISA

Agilent VISA User’s Guide 25
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Building a VISA Application in Windows

program using an application such as Microsoft Visual Studio. In this
case, VISA messages will appear in the Visual Studio output window.
The process for using the Debug Window is:

1 Enable VISA logging from the Agilent IO Control by clicking the
blue 10 icon on the taskbar and then clicking Agilent VISA Options
> VISA Logging > Debug Window.

2 Run your VISA program from Microsoft Visual Studio (or
equivalent application).

3 View error messages in the Visual Studio (or equivalent) output
window.
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Programming with VISA

This chapter describes how to program with VISA. The basics of VISA
are described, including formatted 1/O, events and handlers, attributes,
and locking. Sample programs are also provided and can be found in the
ProgrammingSamples subdirectory

(C:\Program Files\Agilent\IO Libraries Suite\
ProgrammingSamples in a default installation).

Click the 10 Control and select Installation Information to see the
specific installation directories used on your PC. For specific details on
VISA functions, see the VIS4 Online Help.

This chapter contains the following sections:

¢ VISA Resources and Attributes

¢ Using Sessions

* Sending I/O Commands

¢ Using Events and Handlers

e Trapping Errors

* Using Locks
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This section introduces VISA resources and attributes, including:
* VISA Resources
* VISA Attributes

VISA Resources

In VISA, a resource is defined as any device (such as a voltmeter) with
which VISA can provide communication. VISA defines six resource
classes that a complete VISA system, fully compliant with the
VXIplug&play Systems Alliance specification, can implement. Each
resource class includes:

e Attributes to determine the state of a resource or session or to set a
resource or session to a specified state.

e Events for communication with applications.

e Operations (functions) that can be used for the resource class.

A summary description of each resource class supported by Agilent
VISA follows. See VISA Resource Classes in the VISA Online Help for
a description of the attributes, events, and operations for each resource
class.

Although the Servant Device-Side (SERVANT) resource is defined by
the VISA specification, the SERVANT resource is not supported by
Agilent VISA. The SERVANT Resource is intended for advanced users
who need to write code that causes a computer to function as an
instrument rather than as a controller.

Table 4 Descriptions of Resource Classes Supported by Agilent

VISA
Resource Class Interface Types Resource Class Description
Instrument Control Generic, GPIB, Device operations (reading,
(INSTR) GPIB-VXI, Serial,  writing, triggering, etc.).

TCPIP, USB, VXI
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Table 4 Descriptions of Resource Classes Supported by Agilent

VISA
GPIB Bus Interface Generic, GPIB Raw GPIB interface
(INTFC) operations (reading, writing,

Memory Access

Generic,

triggering, etc.).

Address space of a

(MEMACC) GPIB-VXI, VXI memory-mapped bus such as
the VXIbus.
VXI Mainframe Generic, VXI-defined operations and
Backplane GPIB-VXI, VXI properties of each backplane
(BACKPLANE) (GPIB-VXI (or chassis) in a VXIbus
BACKPLANEnot  system.
supported)

TCPIP Socket
(SOCKET)

Generic, TCPIP Operations and properties of
a raw network socket

connection using TCPIP.

VISA Attributes

Agilent VISA User’s Guide

Attributes are associated with resources or sessions. You can use
attributes to determine the state of a resource or session, or to set a
resource or session to a specified state.

For example, you can use the viGetAttribute function to read the state
of an attribute for a specified session, event context, or find list. There
are read only (RO) and read/write (RW) attributes. Use the
viSetAttribute function to modify the state of a read/write attribute for
a specified session, event context, or find list.

The pointer passed to viGetAttribute must point to the exact type
required for that attribute (ViUInt16, Vilnt32, etc.). For example, when
reading an attribute state that returns a ViUInt16, you must declare a
variable of that type and use it for the returned data. If ViString is
returned, you must allocate an array and pass a pointer to that array for
the returned data.

Sample: Reading a VISA Attribute

This code sample reads the state of the VI ATTR. TERMCHAR EN
attribute and changes it if it is not true.
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ViBoolean state, newstate;

newstate=VI_ TRUE;

viGetAttribute (vi, VI ATTR TERMCHAR EN, &state) ;

if (state err !=VI TRUE) viSetAttribute(vi,
VI_ATTR TERMCHAR EN, newstate);
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This section shows how to use VISA sessions, including:
¢ Including the VISA Declarations File (C/C++)

* Adding the visa32.bas File (Visual Basic)

e Opening a Session to a Resource

e Addressing a Session

* Closing a Session

e Searching for Resources

Including the VISA Declarations File (C/C++)

For C and C++ programs, you must include the visa . h header file at
the beginning of every file that contains VISA function calls:

#include "visa.h"

This header file contains the VISA function prototypes and the
definitions for all VISA constants and error codes. The visa.h header
file also includes the visatype.h header file.

The visatype.h header file defines most of the VISA types. The
VISA types are used throughout VISA to specify data types used in the
functions. For example, the viOpenDefaultRM function requires a
pointer to a parameter of type ViSession. If you find ViSession in the
visatype.h header file, you will find that ViSession is eventually
typed as an unsigned long. VISA types are also listed in VIS4 System
Information in the VISA Online Help.

Adding the visa32.bas File (Visual Basic)

Agilent VISA User’s Guide

You must add the visa32.bas Basic module file to your Visual Basic
project. The visa32.bas file contains the VISA function prototypes
and definitions for all VISA constants and error codes.
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Opening a Session

A session is a channel of communication. Sessions must first be opened
on the default resource manager, and then for each resource you will be
using.

* A resource manager session is used to initialize the VISA system. It
is a parent session that knows about all the opened sessions. A
resource manager session must be opened before any other session
can be opened.

* A resource session is used to communicate with a resource on an
interface. A session must be opened for each resource you will be
using. When you use a session you can communicate without
worrying about the type of interface to which it is connected. This
insulation makes applications more robust and portable across
interfaces.

Resource Manager Sessions

There are two parts to opening a communications session with a specific
resource. First, you must open a session to the default resource manager
with the viOpenDefaultRM function. The first call to this function
initializes the default resource manager and returns a session to that
resource manager session. You only need to open the default manager
session once. However, subsequent calls to viOpenDefaultRM return a
unique session to the same default resource manager resource.

Resource Sessions

Next, open a session with a specific resource using the viOpen function.
This function uses the session returned from viOpenDefaultRM and
returns its own session to identify the resource session. The following
shows the function syntax.

viOpenDefaultRM (sesn) ;
viOpen (sesn, rsrcName, accessMode, timeout,
vi);

The session returned from viOpenDefaultRM must be used in the sesn
parameter of the viOpen function. The viOpen function then uses that
session and the resource address specified in the rsrcName parameter to
open a resource session. The vi parameter in viOpen returns a session
identifier that can be used with other VISA functions.
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Your program may have several sessions open at the same time after
creating multiple session identifiers by calling the viOpen function
multiple times. The following table summarizes the parameters in the
previous function calls.

Table 5 Parameters Used in Function Calls

Parameter

Description

sesn

rsrcName

accessMode

timeout

A session returned from the viOpenDefaultRM function that
identifies the resource manager session.

A unique symbolic name of the resource (resource address).

Specifies the modes by which the resource is to be accessed.
The value VI EXCLUSIVE LOCK is used to acquire an
exclusive lock immediately upon opening a session. If a lock
cannot be acquired, the session is closed and an error is
returned. The VI LOAD_CONFIG value is used to configure
attributes specified by some external configuration utility. If
this value is not used, the session uses the default values
provided by this specification.

Multiple access modes can be used simultaneously by
specifying a “bit-wise OR” of the values.

If the accessMode parameter requires a lock, this parameter
specifies the absolute time period (in milliseconds) that the
resource waits to get unlocked before this operation returns
an error. Otherwise, this parameter is ignored.

This is a pointer to the session identifier for this particular
resource session. This pointer will be used to identify this
resource session when using other VISA functions.

Sample: Opening a Resource Session

This code sample shows one way of opening resource sessions with a
GPIB multimeter and a GPIB-VXI scanner. The sample first opens a
session with the default resource manager. The sample then uses the
session returned from the resource manager, and a VISA address, to
open a session with the GPIB device at address 22. You can now
identify that session as dmm when you call other VISA functions.
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The sample again uses the session returned from the resource manager,
with another VISA address, to open a session with the GPIB-VXI
device at primary address 9 and VXI logical address (secondary
address) 24. You will now identify this session as scanner when calling
other VISA functions. See the following section, “Addressing a
Session”, for information on addressing particular devices.

ViSession defaultRM, dmm, scanner;

viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM, "GPIBO::22::INSTR",VI NULL,
VI NULL, &dmm) ;

viOpen (defaultRM, "GPIB-VXIO::24::INSTR",
VI NULL, VI NULL, &scanner) ;

viClose (scanner) ;
viClose (dmm) ;
viClose (defaultRM) ;

Addressing a Session

As shown in the previous section, the rsreName parameter in the
viOpen function is used to identify a specific resource. This parameter
consists of the VISA interface ID and the resource address. The
interface ID is determined when you run the Agilent Connection Expert
utility. The interface ID is usually the VISA interface type followed by a
number.

The following table illustrates the format of the rsrcName for different
VISA interface types. INSTR is an optional parameter that indicates that
you are communicating with a resource that is of type INSTR, meaning
instrument. The keywords are:

e ASRL - used for asynchronous serial devices.
e GPIB - used for GPIB devices and interfaces.
¢  GPIB-VXI - used for GPIB-VXI controllers.

e TCPIP - used for LAN instruments.

e VXI - used for VXI instruments.

¢ USB - used for USB instruments.
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Table 6 The Format of the rsrcName (VISA Address) for Different

Interface Types
Interface  Typical Syntax

ASRL ASRL[board][::INSTR]

GPIB GPIB[board)::primary address|::secondary address][::INSTR]

GPIB GPIB[board]::INTFC

GPIB-V GPIB-VXI[board]::VXI logical address[::INSTR]

XI

GPIB-V GPIB-VXI[board)::MEMACC

XI

GPIB-V GPIB-VXI[board][::VXI logical address]::BACKPLANE

XI

TCPIP TCPIP[board)::host address[::LAN device name]::INSTR

TCPIP TCPIP[board]::host address::port::SOCKET

USB USB[board]::manufacturer ID::model code::serial
number|::USB interface number][::INSTR]

VXI VXI[board)::VXI logical address[::INSTR]

VXI VXl[board]::MEMACC

VXI VXI[board][::VXI logical address]::BACKPLANE

The following table describes the parameters used above.

Table 7  Description of Parameters

Parameter Description
board This optional parameter is used if you have more
than one interface of the same type. The default
value for board is 0.
host address The IP address (in dotted decimal notation) or the

name of the host computer/gateway.
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Table 7 Description of Parameters

LAN device name

manufacturer ID

model code

port

primary address

secondary address

serial number

USB interface
number

VXI logical address

The assigned name for a LAN device. Device
Name depends on LAN Host Device (see
documentaiton that came with your LAN Host
device such as E5S810A). The default is inst().

Manufacturer’s ID for a USB Test & Measurement
class device

Model code of a USB device.

The port number to use for a TCP/IP Socket
connection.

The primary address of the GPIB device.

This optional parameter is the secondary address of
the GPIB device. If no secondary address is
specified, none is assumed.

Serial number of a USB device.

Interface number of a USB device.

Logical address of a VXI instrument within a
mainframe.

Some examples of valid VISA addresses follow.

Table 8 Examples of Valid VISA Addresses

Address String

Description

VXI0::1::INSTR

GPIB-VXI::9::INSTR

GPIB::1::0::INSTR

ASRLI:INSTR
VXI::MEMACC

A VXI device at logical address 1 in VXI
interface VXIO.

A VXI device at logical address 9 in a
GPIB-VXI controlled VXI system.

A GPIB device at primary address 1 and
secondary address 0 in GPIB interface 0.

A serial device located on port 1.

Board-level register access to the VXI
interface.
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GPIB-VXI1::MEMACC

GPIB2::INTFC

VXI::1::BACKPLANE

GPIB-VXI2:: BACKPLANE

GPIB1::SERVANT

VXIO::SERVANT

TCPIPO0::1.2.3.4::999::SOCK

ET

TCPIP::devicename@compa
ny.

com::INSTR
USB::0x1234::125::A22-5::1
NSTR

Board-level register access to GPIB-VXI
interface number 1.

Interface or raw resource for GPIB
interface 2.

Mainframe resource for chassis 1 on the
default VXI system, which is interface 0.

Mainframe resource for default chassis on
GPIB-VXI interface 2.

Servant/device-side resource for GPIB
interface 1.

Servant/device-side resource for VXI
interface 0.

Raw TCPIP access to port 999 at the
specified address.

TCPIP device using VXI-11 located at the
specified address. This uses the default
LAN Device Name of inst0.

USB Test & Measurement class device
with manufacturer ID 0x1234, model code
125, and serial number A22-5. This uses
the device's first available USBTMC
interface, which is usually numbered 0.

Sample: Opening a Session

This sample shows one way to open a VISA session with the GPIB

device at primary address 23.

ViSession defaultRM,

vi;

viOpenDefaultRM (&defaultRM) ;
viOpen (defaultRM, "GPIBO::23::INSTR", VI NULL,

VI NULL, &vi) ;
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viClose (vi) ;
viClose (defaultRM) ;
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Closing a Session

You must use the viClose function to close each session. You can close
the specific resource session, which will free all data structures that had
been allocated for the session. If you close the default resource manager
session, all sessions opened using that resource manager session will be
closed.

Since system resources are also used when searching for resources
(viFindRsrc), the viClose function needs to be called to free up find
lists. See the following section, “Searching for Resources”, for more
information on closing find lists.

Searching for Resources

When you open the default resource manager, you are opening a parent
session that knows about all the other resources in the system. Since the
resource manager session knows about all resources, it has the ability to
search for specific resources and open sessions to these resources. You

can, for example, search an interface for devices and open a session with
one of the devices found.

Use the viFindRsrc function to search an interface for device resources.
This function finds matches and returns the number of matches found
and a handle to the resources found. If there are more matches, use the
viFindNext function with the handle returned from viFindRsrc to get
the next match:

viFindRsrc (sesn, expr, findList, retcnt,
instrDesc) ;

viFindNext (findList, instrDesc);

viClose (findList);
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The parameters are defined as follows.

Table 9 Definitions of Parameters

Parameter Description
sesn The resource manager session.
expr The expression that identifies what to search (see Table
10).
findList A handle that identifies this search. This handle will then be

used as an input to the viFindNext function when finding
the next match.

retent A pointer to the number of matches found.

instrDesc A pointer to a string identifying the location of the match.
Note that you must allocate storage for this string.

The handle returned from viFindRsrc should be closed to free up all the
system resources associated with the search. To close the find object,
pass the findList to the viClose function.

Use the expr parameter of the viFindRsrc function to specify the
interface to search. You can search for devices on the specified
interface. Use the following table to determine what to use for your expr
parameter.

Because VISA interprets strings as regular expressions, the string
GPIB?*INSTR applies to both GPIB and GPIB-VXI devices.

Table 10 Determining What to Use for the expr Parameter

Interface expr Parameter
GPIB GPIB[0-9]*::?*INSTR
VX1 VXI?*INSTR
GPIB-VXI GPIB-VXI?*INSTR
GPIB and GPIB-VXI GPIB?*INSTR
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Table 10 Determining What to Use for the expr Parameter

All VXI 2%VXI[0-9]*::2*INSTR
ASRL ASRL[0-9]*::2*INSTR
All 2*INSTR

Sample: Searching the VXI Interface for Resources

This code sample searches the VXI interface for resources. The number
of matches found is returned in nmatches, and matches points to the
string that contains the matches found. The first call returns the first
match found, the second call returns the second match found, etc.

VI _FIND BUFLEN is defined in the visa . h declarations file.

ViChar buffer [VI_FIND_BUFLEN];
ViRsrc matches=buffer;

ViUInt32 nmatches;

ViFindList list;

viFindRsrc (defaultRM, "VXI?*INSTR", &list,
&nmatches, matches);

viFindNext (list, matches);

viClose (list);
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Sending I/O Commands
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Types of 1/0

This section provides guidelines for sending I/O commands, including:
e Types of I/O

* Using Formatted I/O

e Using Non-Formatted 1/0

Once you have established a communications session with a device, you
can start communicating with that device using VISA's I/O routines.
VISA provides both formatted and non-formatted I/O routines.

* Formatted I/O converts mixed types of data under the control of a
format string. The data is buffered, thus optimizing interface traffic.

¢ Non-formatted I/O sends or receives raw data to or from a device.
With non-formatted I/0, no format or conversion of the data is
performed. Thus, if formatted data is required, it must be done by the
user.

You can choose between VISA's formatted and non-formatted I/O
routines. However, you should not mix formatted I/O and non-formatted
I/0 in the same session. See the following sections for descriptions and
code samples using formatted I/O and non-formatted I/O in VISA.

Using Formatted 1/0

The VISA formatted I/O mechanism is similar to the C stdio
mechanism. The VISA formatted I/O functions are viPrintf, viQueryf,
and viScanf. There are also two non-buffered and non-formatted I/0O
functions that synchronously transfer data, called viRead and viWrite,
and two that asynchronously transfer data, called viReadAsync and
viWriteAsync.

These are raw 1/O functions and do not intermix with the formatted I/O
functions. See “Using Non-Formatted I/0” in this chapter for details.
See the VISA Online Help for more information on how data is
converted under the control of the format string.
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Formatted I/O Functions

As noted, the VISA formatted I/O functions are viPrintf, viQueryf, and
viScanf.

* The viPrintf functions format according to the format string and
send data to a device. The viPrintf function sends separate arg
parameters, while the viVPrintf function sends a list of parameters
in params:

viPrintf(vi, writeFmt([, arglll[, arg2ll, ...1);
viVPrintf (vi, writeFmt, params);

* The viScanf functions receive and convert data according to the
format string. The viScanf function receives separate arg parameters,
while the viVScanf function receives a list of parameters in params:

viScanf (vi, readFmt[, arglll, arg2ll, ...1):
viVScanf (vi, readFmt, params);

e The viQueryf functions format and send data to a device and then
immediately receive and convert the response data. Hence, the
viQueryf function is a combination of the viPrintf and viScanf
functions. Similarly, the viVQueryf function is a combination of the
viVPrintf and viVScanf functions. The viQueryf function sends and
receives separate arg parameters, while the viVQueryf function
sends and receives a list of parameters in params:

viQueryf (vi, writeFmt, readFmt[, argl]
[, arg2]l [, ...1);
viVQueryf (vi, writeFmt, readFmt, params);

Formatted I/O Conversion

The formatted I/0 functions convert data under the control of the format
string. The format string specifies how the argument is converted before
it is input or output. The format specifier sequence consists of a %
(percent) followed by an optional modifier(s), followed by a format
code.

$[modifiers] format code
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(See Table 11, “Descriptions of Format Codes,” on page 45.) Zero or
more modifiers may be used to change the meaning of the format code.
Modifiers are only used when sending or receiving formatted I/O. To
send formatted I/0, the asterisk (*) can be used to indicate that the
number is taken from the next argument.

However, when the asterisk is used when receiving formatted /0O, it
indicates that the assignment is suppressed and the parameter is
discarded. Use the pound sign (#) when receiving formatted I/O to
indicate that an extra argument is used. The following are supported
modifiers. See the viPrintf function in the VISA Online Help for
additional enhanced modifiers (@1, @2, @3, @H, QQ,or @B).

Field Width Field width is an optional integer that specifies how
many characters are in the field. If the viPrintf or viQueryf
(writeFmt) formatted data has fewer characters than specified in the
field width, it will be padded on the left, or on the right if the — flag is
present.

You can use an asterisk (*) in place of the integer in viPrintf or
viQueryf (writeFmt) to indicate that the integer is taken from the
next argument. For the viScanf or viQueryf (readFmf) functions,
you can use a # sign to indicate that the next argument is a reference
to the field width.

The field width modifier is only supported with viPrintf and
viQueryf (writeFmf) format codes d, f, s, and viScanf and
viQueryf (readFmt) format codes ¢, s, and []. (See Table 11 for a
description of format codes.)

Sample: Using Field Width Modifier

The following sample pads numb to six characters and sends it to the
session specified by vi:

int numb = 61;
viPrintf (vi, "%6d\n", numb);

Inserts four spaces, for a total of 6 characters: 61
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Precision Precision is an optional integer preceded by a period.
This modifier is only used with the viPrintf and viQueryf
(writeFmt) functions. The meaning of this argument is dependent on
the conversion character used. You can use an asterisk (*) in place of
the integer to indicate the integer is taken from the next argument.

Table 11 Descriptions of Format Codes

Format Description
Code
d Indicates the minimum number of digits to appear is

specified for the @1, @H, @Q, and @B flags, and the i, o,
u, X, and X format codes.

Indicates the maximum number of digits after the decimal
point is specified.

Indicates the maximum number of characters for the string is
specified.

Indicates the maximum significant digits are specified.

Sample: Using the Precision Modifier

This sample converts numb so that there are only two digits to the
right of the decimal point and sends it to the session specified by vi:

float numb = 26.9345;
viPrintf(vi, "%.2f\n", numb);

Sends: 26.93

Argument Length Modifier The meaning of the optional argument
length modifier h, 1, L, z, orZ is dependent on the conversion
character, as listed in the following table. Note that z and Z are not
ANSI C standard modifiers.
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Table 12 Argument Length Modifiers

Argument Format Description
Length Codes
Modifier

h d,b,B Corresponding argument is a short integer or a
reference to a short integer for d. For b or B, the
argument is the location of a block of data or a
reference to a data array. (B is only used with
viPrintf or viQueryf (writeFmf).)

1 d,f;b,B  Corresponding argument is a long integer or a
reference to a long integer for d. For f, the argument
is a double float or a reference to a double float. For
b or B, the argument is the location of a block of
data or a reference to a data array. (B is only used
with viPrintf or viQueryf (writeFmt).)

L f Corresponding argument is a long double or a
reference to a long double.

z b,B Corresponding argument is an array of floats or a
reference to an array of floats. (B is only used with
viPrintf or viQueryf (writeF'mt).)

Z b,B Corresponding argument is an array of double floats
or a reference to an array of double floats. (B is only
used with viPrintf or viQueryf (writeFmf).)

, Array Size The comma operator is a format modifier that allows
you to read or write a comma-separated list of numbers (only valid
with %d and %f format codes). It is a comma followed by an integer.
The integer indicates the number of elements in the array. The
comma operator has the format of ,dd where dd is the number of
elements to read or write.

For viPrintf or viQueryf (writeFmt), you can use an asterisk (¥) in
place of the integer to indicate that the integer is taken from the next
argument. For viScanf or viQueryf (readFmt), you can use a # sign
to indicate that the next argument is a reference to the array size.
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Sample: Using Array Size Modifier

This sample specifies a comma-separated list to be sent to the session
specified by vi:

int 1ist[5]={101,102,103,104,105};
viPrintf (vi, "$%,5d\n", list);

Sends: 101,102,103,104,105

Special Characters Special formatting character sequences will
send special characters. The following describes the special
characters and what will be sent.

The format string for viPrintf and viQueryf (writeFmt) puts a
special meaning on the newline character (1n). The newline character
in the format string flushes the output buffer to the device.

All characters in the output buffer will be written to the device with
an END indicator included with the last byte (the newline character).
This means you can control at what point you want the data written
to the device. If no newline character is included in the format string,
the characters converted are stored in the output buffer. It will require
another call to viPrintf, viQueryf (writeFmt), or viFlush to have
those characters written to the device.

This can be very useful in queuing up data to send to a device. It can
also raise I/0 performance by doing a few large writes instead of
several smaller writes. The * while using the viScanf functions acts
as an assignment suppression character. The input is not assigned to
any parameters and is discarded.

The grouping operator () in a regular expression has the highest
precedence, the + and * operators in a regular expression have the
next highest precedence after the grouping operator, and the or
operator | in a regular expression has the lowest precedence. The
following table provides detailed descriptions of special characters
and operators. Some example expressions follow in Table 14

Agilent VISA User’s Guide 47



3

48

Programming with VISA

Table 13 Descriptions of Special Characters and Operators

Special Description
Characters and
Operators
? Matches any one character.
\ Makes the character that follows it an ordinary character

instead of special character. For example, when a
question mark follows a backslash (e.g.,” '\?”), it matches
the '?" character instead of any one character.

[list] Matches any one character from the enclosed /ist. A
hyphen can be used to match a range of characters.

[Mist] Matches any character not in the enclosed /ist. A hyphen
can be used to match a range of characters.

Matches 0 or more occurrences of the preceding
character or expression.

+ Matches 1 or more occurrences of the preceding
character or expression.

explexp Matches either the preceding or following expression.
The or operator | matches the entire expression that
precedes or follows it and not just the character that
precedes or follows it. For example, VXI|GPIB means
(VXI) | (GPIB), not VXI(I|G)PIB.

(exp) Grouping characters or expressions.

X1

Sends a blank space.

\n Sends the ASCII line feed character. The END identifier
will also be sent.

\r Sends an ASCII carriage return character.

\t Sends an ASCII TAB character.

i Sends ASCII character specified by octal value.

\" Sends the ASCII double quote character.

\\ Sends a backslash character.
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Table 14 Examples of Expressions and Matches

Example Expression

Sample Matches

GPIB?*INSTR

GPIB[0-9]*::?*INST
R

GPIB[0-9]::?*INSTR

GPIB["0]::?*INSTR

VXI?*INSTR

GPIB-VXI?*INSTR

2%V XI[0-9]*::2*INST
R

ASRL[0-9]*::2*INST
R

ASRLI1+::INSTR

(GPIB|[VXI)?*INSTR

(GPIBO|VXI0)::1::IN
STR

7*INSTR

7*VXI[0-9]*::7*MEM
ACC

VXI0::?7*

2%

Matches GPIBO0::2::INSTR,
GPIB1::1::1::INSTR, and
GPIB-VXI1::8::INSTR

Matches GPIBO0::2::INSTR and
GPIB1::1::1::INSTR but not
GPIB-VXI1::8::INSTR

Matches GPIB0::2::INSTR and
GPIB1::1::1::INSTR but not
GPIB12::8::INSTR

Matches GPIB1::1::1::INSTR but not
GPIBO0::2::INSTR or GPIB12::8::INSTR

Matches VXI0::1::INSTR but not
GPIB-VXI0::1::INSTR

Matches GPIB-VXIO0::1::INSTR but not
VXI0::1::INSTR

Matches VXI0::1::INSTR and
GPIB-VXI0::1::INSTR

Matches ASRL1::INSTR but not
VXI0::5::INSTR

Matches ASRL1::INSTR and ASRL11::INSTR
but not ASRL2::INSTR

Matches GPIB1::5::INSTR and
VXI0::3::INSTR but not ASRL2::INSTR

Matches GPIBO0::1::INSTR and
VXI0::1::INSTR

Matches all INSTR (device) resources

Matches VXI0::MEMACC and
GPIB-VXI1::MEMACC

Matches VXI0::1::INSTR, VXI0::2::INSTR,
and VXI0::MEMACC

Matches all resources
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Format Codes. This table summarizes the format codes for sending and
receiving formatted I/O.

Table 15 Format Codes for Sending and Receiving Formatted 1/0

Format
Codes

Description

viPrintf/viVPrintf and viQueryf/viVqueryf (write Fmt)

d, i
f
c

S

%
0,4, X, X
e,E, g G
n

b, B

Corresponding argument is an integer.
Corresponding argument is a double.
Corresponding argument is a character.

Corresponding argument is a pointer to a null terminated
string.

Sends an ASCII percent (%) character.
Corresponding argument is an unsigned integer.
Corresponding argument is a double.
Corresponding argument is a pointer to an integer.

Corresponding argument is the location of a block of data.

viPrintf/viVPrintf and viQueryf/viVqueryf (read Fmft)

d,i,n
efg

C

s,t,T

0,u,X

Corresponding argument must be a pointer to an integer.
Corresponding argument must be a pointer to a float.

Corresponding argument is a pointer to a character
sequence.

Corresponding argument is a pointer to a string.

Corresponding argument must be a pointer to an unsigned
integer.

Corresponding argument must be a character pointer.

Corresponding argument is a pointer to a data array.

50
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Sample: Receiving Data From a Session

This sample receives data from the session specified by the vi parameter
and converts the data to a string.

char data([180];
viScanf (vi, "%t", data);

Formatted I/O Buffers

The VISA software maintains both a read and write buffer for formatted
I/O operations. Occasionally, you may want to control the actions of
these buffers. You can modify the size of the buffer using the viSetBuf
function. See the VISA Online Help for more information on this
function.

The write buffer is maintained by the viPrintf or viQueryf (writeFmt)
functions. The buffer queues characters to send to the device so that they
are sent in large blocks, thus increasing performance. The write buffer
automatically flushes when it sends a newline character from the format
string. It may occasionally be flushed at other non-deterministic times,
such as when the buffer fills.

When the write buffer flushes, it sends its contents to the device. If you
set the VI ATTR WR_BUF OPER MODE attribute to

VI FLUSH ON_ACCESS, the write buffer will also be flushed every
time a viPrintf or viQueryf operation completes. See “VISA
Attributes” in this chapter for information

on setting VISA attributes.

The read buffer is maintained by the viScanf and viQueryf (readFmt)
functions. It queues the data received from a device until it is needed by
the format string. Flushing the read buffer destroys the data in the buffer
and guarantees that the next call to viScanf or viQueryf reads data
directly from the device rather than data that was previously queued.

If you set the VI. ATTR_ RD BUF_OPER_MODE attribute to

VI _FLUSH_ON_ACCESS, the read buffer will be flushed every time a
viScanf or viQueryf operation completes. See “VISA Attributes” in this
chapter for information on setting VISA attributes.
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You can manually flush the read and write buffers using the viFlush
function. Flushing the read buffer also includes reading all pending
response data from a device. If the device is still sending data, the flush
process will continue to read data from the device until it receives an
END indicator from the device.

Sample: Sending and Receiving Formatted 1/0

This C sample program shows sending and receiving formatted I/O. The
sample opens a session with a GPIB device and sends a comma operator
to send a comma-separated list. This sample program is intended to
show specific VISA functionality and does not include error trapping.
Error trapping, however, is good programming practice and is
recommended in your VISA applications. See “Trapping Errors” in this
chapter for more information.

This sample program is installed on your system in the
ProgrammingSamples subdirectory. See the /O Libraries Suite
Online Help for locations of sample programs on your operating system.

/*formatio.c

This example program makes a multimeter
measurement with a comma-separated list passed
with formatted I/0 and prints the results. You
may need to change the device address. */

#include <visa.h>
#include <stdio.h>

void main () {

ViSession defaultRM, vi;
double res;
double 1list [2] = {1,0.001};

/* Open session to GPIB device at address 22*/

viOpenDefaultRM (&efaultRM) ;

viOpen (defaultRM, "GPIBO::22::INSTR",
VI_NULL,VI NULL, &vi);

/* Initialize device */
viPrintf (vi, "*RST\n");
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/* Set up device and send a comma-separated
list */

viPrintf (vi, "CALC:DBM:REF 50\n");

viPrintf (vi, "MEAS:VOLT:AC? %,2f\n", list);

/* Read results */
viScanf (vi, "$1f", &res);

/* Print results */
printf ("Measurement Results: %1f\n", res);

/* Close session */
viClose (vi) ;
viClose (defaultRM) ;
}

Using Non-Formatted 1/0

Agilent VISA User’s Guide

There are two non-buffered, non-formatted I/O functions that
synchronously transfer data called viRead and viWrite. Also, there are
two non-formatted I/O functions that asynchronously transfer data
called viReadAsync and viWriteAsync. These are raw 1/O functions
and do not intermix with the formatted I/O functions.

Non-Formatted I/O Functions

The non-formatted I/O functions follow. For more information, see the
viRead, viWrite, viReadAsync, viWriteAsync, and viTerminate
functions in the VISA Online Help.

viRead. The viRead function synchronously reads raw data from the
session specified by the vi parameter and stores the results in the
location where buf'is pointing. Only one synchronous read operation
can occur at any one time.

viRead (vi, buf, count, retCount);

viWrite. The viWrite function synchronously sends the data pointed
to by bufto the device specified by vi. Only one synchronous write
operation can occur at any one time.

viWrite (vi, buf, count, retCount);
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viReadAsync. The viReadAsync function asynchronously reads raw
data from the session specified by the vi parameter and stores the
results in the location where buf'is pointing. This operation normally
returns before the transfer terminates. Thus, the operation returns
jobld, which you can use with either viTerminate to abort the
operation or with an I/O completion event to identify which
asynchronous read operation completed.

viReadAsync (vi, buf, count, jobId);

viWriteAsync. The viWriteAsync function asynchronously

sends the data pointed to by buf'to the device specified by vi.

This operation normally returns before the transfer terminates. Thus,
the operation returns jobld, which you can use with either
viTerminate to abort the operation or with an I/O completion event
to identify which asynchronous write operation completed.

viWriteAsync(vi, buf, count, jobId);

Sample: Using Non-Formatted I/O Functions

This sample program illustrates using non-formatted I/O functions to
communicate with a GPIB device. This sample program is intended to
show specific VISA functionality and does not include error trapping.
Error trapping, however, is good programming practice and is
recommended in your VISA applications. See “Trapping Errors” in this
chapter for more information.

/*nonfmtio.c

This example program measures the AC voltage on
a multimeter and prints the results. You may
need to change the device address. */

#include <visa.h>
#include <stdio.h>

void main () {

ViSession defaultRM, vi;
char strres [20];
unsigned long actual;
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/* Open session to GPIB device at address 22 */

viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM, "GPIBO::22::INSTR",
VI_NULL,VI NULL, &vi);

/* Initialize device */
viWrite(vi, (ViBuf)"*RST\n", 5, &actual);

/* Set up device and take measurement */

viWrite (vi, (ViBuf)"CALC:DBM:REF 50\n", 16,
&actual) ;

viWrite (vi, (ViBuf)"MEAS:VOLT:AC? 1, 0.001\n",
23, &actual);

/* Read results */
viRead (vi, (ViBuf)strres, 20, &actual);

/* NULL terminate the string */
strres[actual]l=0;

/* Print results */
printf ("Measurement Results: %s\n", strres);

/* Close session */
viClose (vi) ;
viClose (defaultRM) ;
}
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This section provides guidelines to using events and handlers,
including:

* Events and Attributes
* Using the Callback Method
e Using the Queuing Method

Events and Attributes

Events are special occurrences that require attention from your
application. Event types include Service Requests (SRQs), interrupts,
and hardware triggers. Events will not be delivered unless the
appropriate events are enabled.

VISA cannot call back to a Visual Basic function. Thus, you can only
use the queuing mechanism in viEnableEvent. There is no way to
install a VISA event handler in Visual Basic.

Event Notification

There are two ways you can receive notification that an event has
occurred:

e Install an event handler with vilnstallHandler, and enable one or
several events with viEnableEvent. If the event was enabled with a
handler, the specified event handler will be called when the specified
event occurs. This is called a callback.

VISA cannot call back to a Visual Basic function. This means that you
can only use the VI_QUEUE mechanism in viEnableEvent. There is
no way to install a VISA event handler in Visual Basic.

* Enable one or several events with viEnableEvent and call the
viWaitOnEvent function. The viWaitOnEvent function will
suspend the program execution until the specified event occurs or the
specified timeout period is reached. This is called queuing.
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The queuing and callback mechanisms are suitable for different
programming styles. The queuing mechanism is generally useful for
non-critical events that do not need immediate servicing. The callback
mechanism is useful when immediate responses are needed. These
mechanisms work independently of each other, so both can be enabled
at the same time. By default, a session is not enabled to receive any
events by either mechanism.

The viEnableEvent operation can be used to enable a session to
respond to a specified event type using either the queuing mechanism,
the callback mechanism, or both. Similarly, the viDisableEvent
operation can be used to disable one or both mechanisms. Because the
two methods work independently of each other, one can be enabled or
disabled regardless of the current state of the other.

Events that can be Enabled

The following table shows the events that are implemented for Agilent
VISA for each resource class, where AP = Access Privilege, RO - Read
Only, and RW = Read/Write. Note that some resource classes/events,
such as the SERVANT class, are not implemented by Agilent VISA and
are not listed in the following tables.

Once the application has received an event, information about that event
can be obtained by using the viGetAttribute function on that particular
event context. Use the VISA viReadSTB function to read the status
byte of the service request.

Table 16 Instrument Control (INSTR) Resource Events

VI_EVENT_SERVICE_REQUEST
Notification that a service request was received from the device.

Event Attribute Description A Data Type
P

VI_ATTR _EVENT TYPE Unique logical identifier of the R ViEventTy
event. O pe

Range

VI_EVENT SERVICE RE
Q

VI_EVENT VXI SIGP
Notification that a VXIbus signal or VXIbus interrupt was received from the device.
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Table 16 Instrument Control (INSTR) Resource Events

Event Attribute Description A Data Type Range
P

VI_ATTR _EVENT TYPE Unique logical identifier of the R ViEventTy VI EVENT VXI STOP
event. O pe
R
0]

VI_ATTR_SIGP_STATUS  The 16-bit Status/ID value
_ID retrieved during the IACK cycle
or from the Signal register.

ViUlnt16 0 to FFFF,

VI_EVENT_TRIG
Notification that a trigger interrupt was received from the device. For VISA, the only triggers that can be sensed are VXI
hardware triggers on the assertion edge (SYNC and ON trigger protocols only).

Event Attribute Description A Data Type Range
P

VI_ATTR _EVENT TYPE Unique logical identifier of the R ViEventTy VI EVENT TRIG
event. O pe

VI_ATTR RECV_TRIG I The identifier of the triggering R  Vilntl6 VI TRIG_TTLO to

D mechanism on which the o VI_TRIG TTL7;
specified trigger event was VI_TRIG_ECLO to
received. VI_TRIG_ECL1*

* Agilent VISA can also return VI_TRIG_PANEL IN (exception to the VISA Specification)

VI_EVENT_I10_COMPLETION
Notification that an asynchronous operation has completed.

Event Attribute Description A Data Type Range
P
VI_ATTR _EVENT TYPE Unique logical identifier of the ViEventTy =~ VI EVENT 10 COMPLE
event. pe TION
VI _ATTR STATUS Return code of the asynchronous ViStatus N/A

1/O operation that has completed.

VI_ATTR JOB_ID Job ID of the asynchronous ViJobld N/A

operation that has completed.

VI_ATTR BUFFER Address of a buffer that was used
in an asynchronous operation.

ViBuf N/A

o®” O®”® O® oW
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Table 16 Instrument Control (INSTR) Resource Events
VI_ATTR RET COUNT Actual number of elements that R ViUInt32 0 to FFFFFFFF;
were asynchronously transferred. O
VI_ATTR OPER _NAME Name of the operation generating ViString N/A
the event.
VI_EVENT_USB_INTR
Notification that a vendor-specific USB interrupt was received from the device.
Event Attribute Description A DataType Range
P
VI_ATTR EVENT TYPE Unique logical identifier of the R ViEventTy = VI EVENT USB_INTR
event. O pe
VI_ATTR USB RECV_IN  Specifies the size of the data that R ViUIntl6 0 to FFFFh
TR was received from the USB ¢
SIZE interrupt-IN pipe. This value will
never be larger than the sessions
value of VI. ATTR USB MAX
INTR_SIZE.
VI_ATTR _USB _RECV_IN  Specifies the actual data that was R ViBuf N/A
TR received from the USB o
_DATA interrupt-IN pipe. Querying this
attribute copies the contents of
the data to the users buffer. The
users buffer must be sufficiently
large enough to hold all of the
data.
VI_ATTR_STATUS Specifies the status of the read R ViStatus N/A
operation from the USB ¢

interrupt-IN pipe. If the device
sent more data than the user
specified in

VI _ATTR USB_MAX INTR S
1ZE, then this attribute value will
contain an error code.
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Table 17 Memory Access (MEMACC) Resource Event

VI_EVENT_10_COMPLETION
Notification that an asynchronous operation has completed

Event Attribute Description A Data Type Range
P
VI_ATTR EVENT TYPE Unique logical identifier of the R ViEventTy VI EVENT IO COMPLE
event. O pe TION
VI _ATTR _STATUS Return code of the asynchronous R ViStatus N/A
I/O operation that has completed. O
VI_ATTR _JOB_ID Job ID of the asynchronous R ViJobld N/A
operation that has completed. o
VI_ATTR BUFFER Address of a buffer that wasused R ViBuf N/A
in an asynchronous operation. ¢
VI_ATTR RET COUNT Actual number of elements that R ViUInt32 0 to FFFFFFFF;
were asynchronously transferred. O
VI_ATTR_OPER NAME Name of the operation generating R ViString N/A
the event. o
Table 18 GPIB Bus Interface (INTFC) Resource Events
VI_EVENT_GPIB_CIC
Notification that the GPIB controller has gained or lost CIC (controller in charge) status
Event Attribute Description A Data Type Range
P
VI_ATTR_EVENT TYPE Unique logical identifier of the R ViEventTy = VI EVENT GPIB CIC
event. O pe
VI _ATTR_GPIB_RECV_CIC_ Controller has become R ViBoolean = VI TRUE
STATE controller-in-charge. o VI_FALSE

VI_EVENT_GPIB_TALK

Notification that the GPIB controller has been addressed to talk
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Table 18 GPIB Bus Interface (INTFC) Resource Events
Event Attribute Description A DataType Range
P
VI_ATTR_EVENT TYPE Unique logical identifier of the R ViEventTy = VI EVENT GPIB TAL
event. O pe K
VI_EVENT_GPIB_LISTEN
Notification that the GPIB controller has been addressed to listen.
Event Attribute Description A DataType Range
P
VI_ATTR_EVENT TYPE Unique logical identifier of the R ViEventTy = VI EVENT GPIB LIST
event. O pe EN
VI_EVENT_CLEAR
Notification that the GPIB controller has been sent a device clear message.
Event Attribute Description A Data Type Range
P
VI _ATTR_EVENT TYPE Unique logical identifier of the R ViEventTy = VI EVENT CLEAR
event. O pe
VI_EVENT_TRIGGER
Notification that a trigger interrupt was received from the interface.
Event Attribute Description A Data Type Range
P
VI_ATTR_EVENT TYPE Unique logical identifier of the R ViEventTy = VI_EVENT_TRIG
event. O pe
VI_ATTR RECV_TRIG ID The identifier of the triggering R  Vilntl6 VI_TRIG_SW
mechanism on which the o

specified trigger event was
received.

VI_EVENT 10 _ COMPLETION
Notification that an asynchronous operation has completed.

Agilent VISA User’s Guide

61



3  Programming with VISA

Table 18 GPIB Bus Interface (INTFC) Resource Events

Event Attribute

VI_ATTR_EVENT TYPE

VI_ATTR_STATUS

VI_ATTR _JOB_ID

VI_ATTR_BUFFER

VI_ATTR_RET_COUNT

VI_ATTR_OPER_NAME

Description

Unique logical identifier of the

event.

Return code of the

asynchronous I/O operation that

has completed.

Job ID of the asynchronous
operation that has completed.

Address of buffer used in an
asynchronous operation.

Actual number of elements that

were asynchronously
transferred.

The name of the operation
generating the event.

A
P

oO® o=

om O®” OoO®

ow

Data Type

ViEventTy

pe

ViStatus

ViJobld

ViBuf

ViUInt32

ViString

Range
VI_EVENT _IO_
COMPLETION
N/A
N/A

N/A

0 to FFFFFFFF,

N/A

Table 19 VXI Mainframe Backplane (BACKPLANE) Resource Events

VI_EVENT_TRIG

Notification that a trigger interrupt was received from the backplane. For VISA, the only triggers that can
be sensed are VXI hardware triggers on the assertion edge (SYNC and ON trigger protocols only).

Event Attribute

VI_ATTR_EVENT TYPE

VI_ATTR_RECV_TRIG I
D

Description

Unique logical identifier of the
event.

The identifier of the triggering
mechanism on which the
specified trigger event was
received.

P

A Data Type
R ViEventTy
O pe
R  Vilntl6
¢}

Range

VI_EVENT TRIG

VI_TRIG_TTLO to
VI_TRIG_TTL7;
VI_TRIG_ECLO to
VI_TRIG_ECL1

VI_EVENT_VXI_VME_SYSFAIL
Notification that the VXI/VME SYSFAIL* line has been asserted.
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Table 19 VXI Mainframe Backplane (BACKPLANE) Resource Events

VI_ATTR EVENT TYPE Unique logical identifier of the R ViEventTy VI EVENT VXI VME
event. O pe SYSFAIL

VI_EVENT_VXI_VME_SYSRESET
Notification that the VXI/VME SYSRESET™* line has been reset

Event Attributes Description A Data Type Range
P

VI_ATTR _EVENT TYPE Unique logical identifier of the R ViEventTy VI EVENT VXI VME
event. O pe SYSRESET

Table 20 TCPIP Socket (SOCKET) Resource Event

VI_EVENT 10 _COMPLETION
Notification that an asynchronous operation has completed

Event Attribute Description A DataType Range
P
VI_ATTR_EVENT TYPE Unique logical identifier of the ViEventTy =~ VI_EVENT 10 _COMPLE
event. pe TION
VI_ATTR _STATUS Return code of the asynchronous ViStatus N/A

1/0O operation that has completed.

VI_ATTR JOB ID Job ID of the asynchronous
operation that has completed.

ViJobld N/A

VI_ATTR BUFFER Address of a buffer that was used
in an asynchronous operation.

ViBuf N/A

VI_ATTR RET COUNT Actual number of elements that
were asynchronously transferred.

ViUInt32 0 to FFFFFFFF;

VI_ATTR _OPER NAME Name of the operation generating
the event.

ViString N/A

co®” O® O~ O®W”® O®W OW
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Sample: Reading Event Attributes

Once you have decided which attribute to check, you can read the
attribute using the viGetAttribute function. The following sample
shows one way you could check which trigger line fired when the
VI EVENT TRIG event was delivered.

Note that the context parameter is either the event context passed to your
event handler, or the outcontext specified when doing a wait on event.
See “VISA Attributes” in this chapter for more information on reading
attribute states.

ViIntlé state;

viGetAttribute (context, VI ATTR RECV_TRIG ID,
&state)

Using the Callback Method

The callback method of event notification is used when an immediate
response to an event is required. To use the callback method for
receiving notification that an event has occurred, you must do the
following.

¢ Install an event handler with the vilnstallHandler function

¢ Enable one or several events with the viEnableEvent function

When the enabled event occurs, the installed event handler is called.

Sample: Using the Callback Method

This sample shows one way you can use the callback method.

ViStatus VI FUNCH my handler (ViSession vi,
ViEventType eventType, ViEvent context, ViAddr
usrHandle) {

/* your event handling code here */
return VI SUCCESS;

}
main () {
ViSession vi;
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ViAddr addr=0;

viInstallHandler (vi, VI _EVENT SERVICE REQ,
my handler, addr);

viEnableEvent (vi, VI _EVENT SERVICE REQ,
VI HNDLR, VI NULL);

/* your code here */

viDisableEvent (vi, VI _EVENT SERVICE REQ,
VI HNDLR) ;

viUninstallHandler (vi, VI _EVENT SERVICE REQ,
my handler, addr);

Installing Handlers

VISA allows applications to install multiple handlers for an event type
on the same session. Multiple handlers can be installed through multiple
invocations of the vilnstallHandler operation, where each invocation
adds to the previous list of handlers.

If more than one handler is installed for an event type, each of the
handlers is invoked on every occurrence of the specified event(s). VISA
specifies that the handlers are invoked in Last In First Out (LIFO) order.
Use the following function when installing an event handler:

viInstallHandler (vi, eventType, handler,
userHandle) ;

These parameters are defined as follows.

Table 21 Parameters Used to Install a Handler

Parameter Description
vi The session on which the handler will be installed.
eventType The event type that will activate the handler.
handler The name of the handler to be called.
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Table 21 Parameters Used to Install a Handler

userHandle A user value that uniquely identifies the handler for the
specified event type.

The userHandle parameter allows you to assign a value to be used with
the handler on the specified session. Thus, you can install the same
handler for the same event type on several sessions with different
userHandle values. The same handler is called for the specified event

type.

However, the value passed to userHandle is different. Therefore the
handlers are uniquely identified by the combination of the handler and
the userHandle. This may be useful when you need a different handling
method depending on the userHandle.

Sample: Installing an Event Handler

This sample shows how to install an event handler to call my_handler
when a Service Request occurs. Note that VI EVENT SERVICE REQ
must also be an enabled event with the viEnableEvent function for the
service request event to be delivered.

viInstallHandler (vi, VI_EVENT SERVICE REQ,
my handler, addr);

Use the viUninstallHandler function to uninstall a specific handler, or
you can use wildcards (VI_ ANY HNDLR in the handler parameter) to
uninstall groups of handlers. See viUninstallHandler in the VIS4
Online Help for more details on this function.

Writing the Handler

The handler installed needs to be written by the programmer. The event
handler typically reads an associated attribute and performs some sort of
action. See the event handler in the sample program later in this section.

Enabling Events

Before an event can be delivered, it must be enabled using the
viEnableEvent function. This function causes the application to be
notified when the enabled event has occurred, where the parameters are:
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viEnableEvent (vi, eventType, mechanism,
context) ;

Using VI_QUEUE in the mechanism parameter specifies a queuing
method for the events to be handled. If you use both VI QUEUE and
one of the mechanisms listed above, notification of events will be sent
to both locations. See the next subsection for information on the
queuing method.

Table 22 Description of Parameters Used to Install a Handler

Parameter Description

vi The session on which the handler will be installed.
eventType The type of event to enable.

mechanism The mechanism by which the event will be enabled. It can
be enabled in several different ways. You can use
VI_HNDLR in this parameter to specify that the installed
handler will be called when the event occurs. Use
VI_SUSPEND HNDLR in this parameter, which puts the
events in a queue and waits to call the installed handlers
until viEnableEvent is called with VI HNDLR specified in
the mechanism parameter. When viEnableEvent is called
with VI_HNDLR specified, the handler for each queued
event will be called.

context Not used in VISA 1.0. Use VI NULL.

Sample: Enabling a Hardware Trigger Event
This sample illustrates enabling a hardware trigger event.

viInstallHandler (vi, VI _EVENT TRIG,
my handler, &addr) ;

viEnableEvent (vi, VI EVENT TRIG, VI HNDLR,
VI NULL) ;

The VI_HNDLR mechanism specifies that the handler installed for
VI_EVENT TRIG will be called when a hardware trigger occurs.

If you specify VI ALL_ ENABLE EVENTS in the eventType
parameter, all events that have previously been enabled on the specified
session will be enabled for the mechanism specified in this function call.
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Use the viDisableEvent function to stop servicing the event specified.

Sample: Trigger Callback

This sample program installs an event handler and enables the trigger
event. When the event occurs, the installed event handler is called. This
program is intended to show specific VISA functionality and does not
include error trapping. Error trapping, however, is good programming
practice and is recommended in your VISA applications. See “Trapping
Errors” in this chapter for more information.

This sample program is installed on your system in the
ProgrammingSamples subdirectory. See the IO Libraries Suite
Online Help for locations of sample programs.

/* evnthdlr.c

This example program illustrates installing an
event handler to be called when a trigger
interrupt occurs. Note that you may need to
change the address. */

#include <visa.h>
#include <stdio.h>

/* trigger event handler */

ViStatus VI FUNCH myHdlr (ViSession vi,
ViEventType eventType, ViEvent ctx, ViAddr
userHdlr) {

ViIntlé trigld;

/* make sure it is a trigger event */
if (eventType!=VI EVENT TRIG) {
/* Stray event, so ignore */
return VI SUCCESS;
}

/* print the event information */

printf ("Trigger Event Occurred!\n");

printf ("...0Original Device Session =
vi);

%1d\n",

/* get the trigger that fired */
viGetAttribute (ctx, VI_ATTR RECV_TRIG ID,
&trigld) ;
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printf ("Trigger that fired: ");
switch (trigId) {
case VI TRIG TTLO:
printf ("TTLO") ;
break;
default:
printf ("<other 0x%x>", trigId);
break;

}
printf ("\n");

return VI SUCCESS;
}

void main () {
ViSession defaultRM, vi;

/* open session to VXI device */

viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM, "VXIO::24::INSTR", VI NULL,
VI _NULL, &vi);

/* select trigger line TTLO */
viSetAttribute (vi, VI _ATTR TRIG ID,
VI _TRIG_TTLO) ;
/* install the handler and enable it */
viInstallHandler (vi, VI _EVENT TRIG, myHdlr,
(ViAddr) 10) ;
viEnableEvent (vi, VI EVENT TRIG, VI HNDLR,
VI_NULL) ;
/* fire trigger line, twice */
viAssertTrigger (vi, VI_TRIG_ PROT SYNC);
viAssertTrigger (vi, VI _TRIG_ PROT SYNC);

/* unenable and uninstall the handler */
viDisableEvent (vi, VI _EVENT TRIG, VI HNDLR);

viUninstallHandler (vi, VI EVENT TRIG, myHdlr,
(ViAddr) 10) ;
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/* close the sessions */
viClose (vi) ;

viClose (defaultRM) ;

}

Sample: SRQ Callback

This program installs an event handler and enables an SRQ event. When
the event occurs, the installed event handler is called. This sample
program is intended to show specific VISA functionality and does not
include error trapping. Error trapping, however, is good programming
practice and is recommended in your VISA applications. See “Trapping
Errors” in this chapter for more information.

This program is installed on your system in the
ProgrammingSamples subdirectory. See the IO Libraries Suite
Online Help for locations of sample programs.

/* srqghdlr.c

This example program illustrates installing an
event handler to be called when an SRQ interrupt
occurs. Note that you may need to change the
address. */

#include <visa.h>

#include <stdio.h>

#if defined ( WIN32)
#include <windows.h> /* for Sleep() */
#define YIELD Sleep( 10 )

#elif defined (_WINDOWS)

#include <io.h> /* for wyield */
#define YIELD _wyield()
#else

#include <unistd.h>
#define YIELD sleep (1)
#endif

int srgOccurred;
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/* trigger event handler */

ViStatus VI FUNCH mySrgHdlr (ViSession vi,
ViEventType

eventType, ViEvent ctx, ViAddr userHdlr) {

ViUIntl6 statusByte;

/* make sure it is an SRQ event */
if (eventType!=VI EVENT SERVICE REQ) {
/* Stray event, so ignore */
printf ( "\nStray event of type 0x%1x\n",
eventType );
return VI SUCCESS;
}

/* print the event information */

printf ("\nSRQ Event Occurred!\n");

printf("...Original Device Session = %1d\n",
vi);

/* get the status byte */

viReadSTB (vi, &statusByte);

printf("...Status byte is 0x%x\n",
statusByte) ;

srgOccurred = 1;
return VI SUCCESS;
}

void main () {
ViSession defaultRM, vi;
long count;

/* open session to message based VXI device */
viOpenDefaultRM (&defaultRM) ;
viOpen (defaultRM, "GPIB-VXIO::24::INSTR",

VI NULL, VI NULL, &vi);

/* Enable command error events */
viPrintf ( vi, "*ESE 32\n" );

/* Enable event register interrupts */
viPrintf( vi, "*SRE 32\n" );
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/* install the handler and enable it */
viInstallHandler (vi, VI _EVENT SERVICE REQ,
mySrgHdlr,
(ViAddr)10) ;
viEnableEvent (vi, VI _EVENT SERVICE REQ,
VI HNDLR, VI_NULL);

srgOccurred = 0;

/* Send a bogus command to the message-based
device to cause an SRQ. Note: 'IDN' causes the
error -- 'IDN?' is the correct syntax */
viPrintf ( vi, "IDN\n" );

/* Wait a while for the SRQ to be generated and
for the handler to be called. Print something
while we wait */

printf ("Waiting for an SRQ to be generated.");
for (count = 0 ; (count < 10) &&

(srgOccurred == 0) ;count++) {

long count2 = 0;

printf( "." );

while ( (count2++ < 100) && (srgOccurred ==0)
) {YIELD;

}
}
printf( "\n" );

/* disable and uninstall the handler */

viDisableEvent (vi, VI _EVENT SERVICE REQ,
VI_HNDLR);

viUninstallHandler (vi, VI _EVENT SERVICE REQ,
mySrgqHdlr, (ViAddr)10);

/* Clean up - do not leave device in error
state */
viPrintf ( vi, "*CLS\n" );

/* close the sessions */
viClose (vi) ;
viClose (defaultRM) ;

printf( "End of program\n" );}
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Using the Queuing Method
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The queuing method is generally used when an immediate response
from your application is not needed. To use the queuing method for
receiving notification that an event has occurred, you must do the
following:

¢ Enable one or several events with the viEnableEvent function.

*  When ready to query, use the viWaitOnEvent function to check for
queued events.

If the specified event has occurred, the event information is retrieved
and the program returns immediately. If the specified event has not
occurred, the program suspends execution until a specified event occurs
or until the specified timeout period is reached.

Sample: Using the Queuing Method
This sample program shows one way you can use the queuing method.

main () ;

ViSession vi;
ViEventType eventType;
ViEvent event;

viEnableEvent (vi, VI_EVENT SERVICE REQ,
VI_QUEUE, VI NULL);

viWaitOnEvent (vi, VI _EVENT SERVICE REQ,
VI TMO_ INFINITE, &eventType, &event);

viClose (event) ;

viDisableEvent (vi, VI _EVENT SERVICE REQ,
VI_QUEUE) ;

}
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Enabling Events

Before an event can be delivered, it must be enabled using the
viEnableEvent function:

viEnableEvent (vi, eventType, mechanism,
context) ;

These parameters are defined as follows:

Table 23 Descriptions of Parameters Used to Enable Events

Parameter Description
vi The session the handler will be installed on.
eventType The type of event to enable.
mechanism The mechanism by which the event will be enabled. Specify

VI_QUEUE to use the queuing method.

context Not used in VISA 1.0. Use VI_NULL.

When you use VI_QUEUE in the mechanism parameter, you are
specifying that the events will be put into a queue. Then, when a
viWaitOnEvent function is invoked, the program execution will
suspend until the enabled event occurs or the timeout period specified is
reached. If the event has already occurred, the viwaitOnEvent function
will return immediately.

Sample: Enabling a Hardware Trigger Event
This sample illustrates enabling a hardware trigger event.

viEnableEvent (vi, VI_EVENT TRIG, VI QUEUE,
VI _NULL) ;

The VI_QUEUE mechanism specifies that when an event occurs, it will
go into a queue. If you specify VI ALL_ENABLE EVENTS in the
eventType parameter, all events that have previously been enabled on
the specified session will be enabled for the mechanism specified in this
function call. Use the viDisableEvent function to stop servicing the
event specified.
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Wait on the Event

When using the viWaitOnEvent function, specify the session, the event
type to wait for, and the timeout period to wait:

viWaitOnEvent (vi, inEventType, timeout,
outEventType, outContext);

The event must have previously been enabled with VI QUEUE
specified as the mechanism parameter.

Sample: Wait on Event for SRQ
This sample shows how to install a wait on event for service requests.

viEnableEvent (vi, VI EVENT SERVICE REQ,
VI QUEUE, VI NULL);

viWaitOnEvent (vi, VI EVENT SERVICE REQ,
VI TMO_ INFINITE, &eventType, &event);

viDisableEvent (vi, VI EVENT SERVICE REQ,
VI QUEUE) ;

Every time a wait on event is invoked, an event context object is
created. Specifying VI TMO_INFINITE in the timeout parameter
indicates that the program execution will suspend indefinitely until the
event occurs. To clear the event queue for a specified event type, use the
viDiscardEvents function.

Sample: Trigger Event Queuing

This program enables the trigger event in a queuing mode. When the
viWaitOnEvent function is called, the program will suspend operation
until the trigger line is fired or the timeout period is reached. Since the
trigger lines were already fired and the events were put into a queue, the
function will return and print the trigger line that fired.

This program is intended to show specific VISA functionality and does
not include error trapping. Error trapping, however, is good
programming practice and is recommended in your VISA applications.
See “Trapping Errors” in this chapter for more information.
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This sample program is installed on your system in the
ProgrammingSamples subdirectory. See the /O Libraries Suite
Online Help for locations of sample programs.

/* evntqueu.c

This sample program illustrates enabling an
event queue using viWaitOnEvent. Note that you
must change the device address. */

#include <visa.h>
#include <stdio.h>

void main () {
ViSession defaultRM, vi;
ViEventType eventType;
ViEvent eventVi;
ViStatus err;
ViIntle6e trigld;

/* open session to VXI device */

viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM, "VXIO::24::INSTR", VI NULL,
VI _NULL, &vi);

/* select trigger line TTLO */
viSetAttribute (vi, VI _ATTR TRIG ID,
VI_TRIG_TTLO) ;

/* enable the event */
viEnableEvent (vi, VI _EVENT TRIG, VI QUEUE,
VI _NULL) ;

/* fire trigger line, twice */
viAssertTrigger (vi, VI TRIG PROT_ SYNC);
viAssertTrigger (vi, VI TRIG PROT_ SYNC) ;

/* Wait for the event to occur */

err=viWaitOnEvent (vi, VI _EVENT TRIG, 10000,
&eventType, &eventVi);

if (err==VI_ERROR TMO) {
printf ("Timeout Occurred! Event not
received.\n");

return;

}
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/* print the event information */

printf ("Trigger Event Occurred!\n");

printf("...Original Device Session = %1d\n",
vi);

/* get trigger that fired */
viGetAttribute (eventVi, VI _ATTR RECV_TRIG_ID,
&trigId) ;
printf ("Trigger that fired: ");
switch (trigId) {
case VI TRIG TTLO:
printf ("TTLO") ;
break;
default:
printf ("<other 0x%x>",trigId);
break;
}
printf ("\n");

/* close the context before continuing */
viClose (eventVi) ;

/* get second event */
err=viWaitOnEvent (vi, VI _EVENT TRIG, 10000,
&eventType, &eventVi);
if (err==VI_ERROR TMO) {
printf ("Timeout Occurred! Event not
received.\n");
return;

}

printf ("Got second event\n");

/* close the context before continuing */
viClose (eventVi) ;

/* disable event */
viDisableEvent (vi, VI _EVENT TRIG, VI QUEUE) ;

/* close the sessions */
viClose (vi) ;
viClose (defaultRM) ;
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This section provides guidelines for trapping errors, including:
* Trapping Errors

e Exception Events

Trapping Errors

The sample programs in this guide show specific VISA functionality
and do not include error trapping. Error trapping, however, is good
programming practice and is recommended in all your VISA application
programs. To trap VISA errors you must check for VI_SUCCESS after
each VISA function call.

If you want to ignore WARNINGS, you can test to see if err is less than
(<) VI_SUCCESS. Since WARNINGS are greater than VI SUCCESS
and ERRORS are less than VI_SUCCESS, err_handler would only be
called when the function returns an ERROR. For example:

if (err < VI_SUCCESS) err handler (vi, err);

Sample: Checking for VI_SUCCESS

This sample illustrates checking for VI SUCCESS. If VI _SUCCESS is
not returned, an error handler (written by the programmer) is called.
This must be done with each VISA function call.

ViStatus err;

err=viPrintf (vi, "*RST\n");
if (err < VI _SUCCESS) err handler(vi, err);

Sample: Printing Error Code

The following error handler prints a user-readable string describing the
error code passed to the function:

void err handler (ViSession vi, ViStatus err) {
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char err msg[1024]={0};
viStatusDesc (vi, err,
printf ("ERROR = %s\n",
return;

err msg);
err msg);

Sample: Checking Instrument Errors

When programming instruments, it is good practice to check the

3

instrument to ensure there are no instrument errors after each instrument

function. This sample uses a SCPI command to check a specific
instrument for errors.

void system err () {

ViStatus err;
char buf[1024]={0};
int err no;

err=viPrintf (vi, "SYSTEM:ERR?\n");

if (err < VI _SUCCESS) err handler (vi, err);
err=viScanf (vi, "%d%t", &err no, &buf);
if (err < VI _SUCCESS) err handler (vi, err);
while (err no >0) {

printf ("Error Found: %d,%$s\n", err no,

buf) ;

err=viScanf (vi, "%d%t", &err no, &buf);
}
err=viFlush(vi, VI READ BUF);
if (err < VI _SUCCESS) err handler (vi, err);
err=viFlush(vi, VI WRITE BUF);
if (err < VI _SUCCESS) err handler (vi, err);

Exception Events

Agilent VISA User’s Guide

An alternative to trapping VISA errors by checking the return status
after each VISA call is to use the VISA exception event. On sessions
where an exception event handler is installed and

VI_EVENT EXCEPTION is enabled, the exception event handler is
called whenever an error occurs while executing an operation.
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Exception Handling Model

The exception-handling model follows the event-handling model for
callbacks, and it uses the same operations as those used for general
event handling. For example, an application calls vilnstallHandler and
viEnableEvent to enable exception events. The exception event is like
any other event in VISA, except that the queueing and suspended
handler mechanisms are not allowed.

When an error occurs for a session operation, the exception handler is
executed synchronously. That is, the operation that caused the exception
blocks until the exception handler completes its execution. The
exception handler is executed in the context of the same thread that
caused the exception event.

When invoked, the exception handler can check the error condition and
instruct the exception operation to take a specific action. It can instruct
the exception operation to continue normally (by returning
VI_SUCCESS) or to not invoke any additional handlers in the case of
handler nesting (by returning VI SUCCESS NCHAIN).

As noted, an exception operation blocks until the exception handler
execution is completed. However, an exception handler sometimes may
prefer to terminate the program prematurely without returning the
control to the operation generating the exception. VISA does not
preclude an application from using a platform-specific or
language-specific exception handling mechanism from within the VISA
exception handler.

For example, the C++ try/catch block can be used in an application in
conjunction with the C++ throw mechanism from within the VISA
exception handler. When using the C++ try/catch/throw or other
exception-handling mechanisms, the control will not return to the VISA
system. This has several important repercussions:

1 If multiple handlers were installed on the exception event, the
handlers that were not invoked prior to the current handler will not be
invoked for the current exception.

2 The exception context will not be deleted by the VISA system when
a C++ exception is used. In this case, the application should delete
the exception context as soon as the application has no more use for
the context, before terminating the session. An application should
use the viClose operation to delete the exception context.

Agilent VISA User’s Guide



Programming with VISA 3

3 Code in any operation (after calling an exception handler) may not be
called if the handler does not return. For example, local allocations
must be freed before invoking the exception handler, rather than after
it.

One situation in which an exception event will not be generated is in the

case of asynchronous operations. If the error is detected after the

operation is posted (i.e., once the asynchronous portion has begun), the
status is returned normally via the I/O completion event.

However, if an error occurs before the asynchronous portion begins (i.c.,
the error is returned from the asynchronous operation itself), then the
exception event will still be raised. This deviation is due to the fact that
asynchronous operations already raise an event when they complete,
and this I/O completion event may occur in the context of a separate
thread previously unknown to the application. In summary, a single
application event handler can easily handle error conditions arising from
both exception events and failed asynchronous operations.

Using the VI_EVENT_EXCEPTION Event

You can use the VI EVENT EXCEPTION event as notification that an
error condition has occurred during an operation invocation. The
following table describes the VI EVENT EXCEPTION event
attributes.

Table 24 VI EVENT EXCEPTION Event Attributes.

Attribute Name Access Privilege Data Type Range Default
VI_ATTR_EVENT TYPE RO  Global ViEventType VI_EVENT_EXCEPTIO N/A
N
VI_ATTR_STATUS RO  Global ViStatus N/A N/A
VI_ATTR_OPER_NAME RO  Global ViString N/A N/A
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Sample: Exception Events

/* This is an example of how to use exception
events to trap VISA errors. An exception event
handler must be installed and exception events
enabled on all sessions where the exception
handler is used.*/

#include <stdio.h>
#include <visa.h>
ViStatus _ stdcall myExceptionHandler (
ViSession vi,
ViEventType eventType,
ViEvent context,
ViAddr usrHandle
) A

ViStatus exceptionErrNbr;

char nameBuffer[256];
ViString functionName = nameBuffer;
char errStrBuffer[256];

/* Get the error value from the exception
context */
viGetAttribute ( context, VI ATTR STATUS,
&exceptionErrNbr );
/* Get the function name from the exception
context */
viGetAttribute ( context, VI ATTR OPER NAME,
functionName ) ;
errStrBuffer[0] = 0;
viStatusDesc( vi, exceptionErrNbr,
errStrBuffer );

printf ("ERROR: Exception Handler reports\n"
"(%$s)\n","VISA function '%$s' failed with
error 0x%1x\n", "functionName,
exceptionErrNbr, errStrBuffer );
return VI SUCCESS;
}
void main () {
ViStatus status;
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ViSession drm;
ViSession vi;
ViAddr myUserHandle = 0;

status = viOpenDefaultRM( &drm ) ;
if ( status < VI SUCCESS ) {
printf ( "ERROR: viOpenDefaultRM failed with
error = 0x%1x\n", status );
return;

}

/* Install the exception handler and enable
events for it */
status = viInstallHandler (drm,
VI EVENT EXCEPTION, myExceptionHandler,
myUserHandle) ;
if ( status < VI SUCCESS )

printf ( "ERROR: viInstallHandler failed
with error 0x%1x\n", status );

}

status = viEnableEvent (drm, VI EVENT EXCEPTION,
VI HNDLR, VI NULL);
if ( status < VI _SUCCESS ) {
printf ( "ERROR: viEnableEvent failed with
error 0x%1lx\n", status );

}

/* Generate an error to demonstrate that the
handler will be called */
status = viOpen( drm, "badVisaName", NULL,
NULL, &vi );
if ( status < VI SUCCESS ) {

printf ("ERROR: viOpen failed with error
Ox%1lx\n"
"Exception Handler should have been
called\n"
"before this message was printed.\n",status

);
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Using Locks

In VISA, applications can open multiple sessions to a VISA resource
simultaneously. Applications can, therefore, access a VISA resource
concurrently through different sessions. However, in certain cases,
applications accessing a VISA resource may want to restrict other
applications from accessing that resource.

Lock Functions

For example, when an application needs to perform successive write
operations on a resource, the application may require that, during the
sequence of writes, no other operation can be invoked through any other
session to that resource. For such circumstances, VISA defines a
locking mechanism that restricts access to resources.

The VISA locking mechanism enforces arbitration of accesses to VISA
resources on a per-session basis. If a session locks a resource, operations
invoked on the resource through other sessions either are serviced or are
returned with an error, depending on the operation and the type of lock
used.

If a VISA resource is not locked by any of its sessions, all sessions have
full privilege to invoke any operation and update any global attributes.
Sessions are not required to have locks to invoke operations or update
global attributes. However, if some other session has already locked the
resource, attempts to update global attributes or invoke certain
operations will fail.

See descriptions of the individual VISA functions in the VIS4 Online
Help to determine which would fail when a resource is locked.

viLock/viUnlock Functions

84

The VISA viLock function is used to acquire a lock on a resource.

vilLock(vi, lockType, timeout, requestedKey,
accessKey) ;

The VI ATTR_RSRC LOCK STATE attribute specifies the current
locking state of the resource on the given session, which can be either
VI NO_LOCK, VI _EXCLUSIVE LOCK, or VI SHARED LOCK.
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The VISA viUnlock function is then used to release the lock on a
resource. If a resource is locked and the current session does not have
the lock, the error VI ERROR_RSRC_LOCKED is returned.

VISA Lock Types
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VISA defines two different types of locks: Exclusive Lock and Shared
Lock.

Exclusive Lock - A session can lock a VISA resource using the lock
type VI EXCLUSIVE LOCK to get exclusive access privileges to
the resource. This exclusive lock type excludes access to the resource
from all other sessions.

If a session has an exclusive lock, other sessions cannot modify
global attributes or invoke operations on the resource. However, the
other sessions can still get attributes.

Shared Lock - A session can share a lock on a VISA resource with
other sessions by using the lock type VI SHARED LOCK. Shared
locks in VISA are similar to exclusive locks in terms of access
privileges, but can still be shared between multiple sessions.

If a session has a shared lock, other sessions that share the lock can
also modify global attributes and invoke operations on the resource
(of course, unless some other session has a previous exclusive lock
on that resource). A session that does not share the lock will lack
these capabilities.

Locking a resource restricts access from other sessions, and in the case
where an exclusive lock is acquired, ensures that operations do not fail
because other sessions have acquired a lock on that resource. Thus,
locking a resource prevents other, subsequent sessions from acquiring
an exclusive lock on that resource. Yet, when multiple sessions have
acquired a shared lock, VISA allows one of the sessions to acquire an
exclusive lock along with the shared lock it is holding.

Also, VISA supports nested locking. That is, a session can lock the
same VISA resource multiple times (for the same lock type) via
multiple invocations of the viLock function. In such a case, unlocking
the resource requires an equal number of invocations of the viUnlock
function. Nested locking is explained in detail later in this section.
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Some VISA operations may be permitted even when there is an
exclusive lock on a resource, or some global attributes may not be read
when there is any kind of lock on the resource. These exceptions, when
applicable, are mentioned in the descriptions of the individual VISA
functions and attributes.

See the VISA Online Help for descriptions of individual functions to
determine which are applicable for locking and which are not restricted
by locking.

Sample: Exclusive Lock

This sample shows a session gaining an exclusive lock to perform the
viPrintf and viScanf VISA operations on a GPIB device. It then
releases the lock via the viUnlock function.

/* lockexcl.c

This example program queries a GPIB device for
an identification string and prints the results.
Note that you may need to change the address. */

#include <visa.h>
#include <stdio.h>

void main () {

ViSession defaultRM, vi;
char buf [256] = {0};

/* Open session to GPIB device at address 22 */

viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM, "GPIBO::22::INSTR",
VI_NULL,VI NULL, &vi);

/* Initialize device */
viPrintf (vi, "*RST\n");
/* Make sure no other process or thread does

anything to this resource between viPrintf and
viScanf calls */

viLock (vi, VI _EXCLUSIVE LOCK, 2000, VI NULL,
VI_NULL) ;
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/* Send an *IDN? string to the device */
viPrintf (vi, "*IDN?\n");

/* Read results */
viScanf (vi, "%t", &buf);

/* Unlock this session so other processes and
threads can use it */
viUnlock (vi);

/* Print results */
printf ("Instrument identification string:
$s\n", buf);

/* Close session */
viClose (vi);
viClose (defaultRM);}

Sample: Shared Lock

This sample shows a session gaining a shared lock with the accessKey
called lockkey. Other sessions can now use this accessKey in the
requestedKey parameter of the viLock function to share access on the
locked resource. This sample then shows the original session acquiring
an exclusive lock while maintaining its shared lock.

When the session holding the exclusive lock unlocks the resource via
the viUnlock function, all the sessions sharing the lock again have all
the access privileges associated with the shared lock.

/* lockshr.c

This example program queries a GPIB device for
an identification string and prints the results.
Note that you must change the address. */

#include <visa.h>
#include <stdio.h>

void main () {

ViSession defaultRM, vi;
char buf [256] = {0};
char lockkey [256] = {0};
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/* Open session to GPIB device at address 22 */

viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM, "GPIBO::22::INSTR",
VI_NULL,VI NULL, &vi) ;

/* acquire a shared lock so only this process

and processes that we know about can access

this resource */

viLock (vi, VI SHARED LOCK, 2000, VI NULL,
lockkey) ;

/* at this time, we can make 'lockkey'
available to other processes that we know
about. This can be done with shared memory or
other inter-process communication methods.
These other processes can then call
"vilLock (vi, VI SHARED LOCK, 2000, lockkey,
lockkey)" and they will also have access to
this resource. */

/* Initialize device */
viPrintf (vi, "*RST\n");

/* Make sure no other process or thread does
anything to this resource between the
viPrintf () and the viScanf()calls Note: this
also locks out the processes with which we
shared our 'shared lock' key. */

viLock (vi, VI_EXCLUSIVE LOCK, 2000,
VI_NULL,VI NULL);

/* Send an *IDN? string to the device */
viPrintf (vi, "*IDN?\n");

/* Read results */
viScanf (vi, "%t", &buf);

/* unlock this session so other processes and
threads can use it */
viUnlock (vi);

/* Print results */
printf ("Instrument identification string:
$s\n", buf);
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/* release the shared lock also*/
viUnlock (vi);

/* Close session */
viClose (vi);
viClose (defaultRM);

3
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Programming via GPIB and VXI

VISA supports three interfaces you can use to access GPIB (General
Purpose Interface Bus) and VXI (VME eXtension for Instrumentation)
instruments: GPIB, VXI, and GPIB-VXI.

This chapter provides information to program GPIB and VXI devices
via the GPIB, VXI or GPIB-VXI interfaces, including:

¢ GPIB and VXI Interfaces Overview

* Using High-Level Memory Functions

¢ Using Low-Level Memory Functions

¢ Using High/Low-Level Memory I/O Methods

* Using the Memory Access Resource

¢ Using VXI-Specific Attributes

See Chapter 3, “Programming with VISA ”, for general information on

VISA programming for the GPIB, VXI, and GPIB-VXI interfaces. See
the VISA Online Help for information on the specific VISA functions.
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This section provides an overview of the GPIB, GPIB-VXI, and VXI
interfaces, including:

¢ General Interface Information
e GPIB Interfaces Overview

e VXI Interfaces Overview

General Interface Information

VISA supports three interfaces you can use to access instruments or
devices: GPIB, VXI, and GPIB-VXI. The GPIB interface can be used to
access VXI instruments via a Command Module. In addition, the VXI
backplane can be directly accessed with the VXI or GPIB-VXI
interfaces.

What is an I/O Interface?

An I/0 interface can be defined as both a hardware interface and as a
software interface. Connection Expert is used to associate a unique
interface name with a hardware interface. Agilent IO Libraries Suite
uses a VISA interface name to identify an interface. This information
is passed in the parameter string of the viOpen function call in a VISA
program.

Connection Expert assigns a VISA interface name to the interface
hardware, and other necessary configuration values for an interface
when the interface is configured. See the Agilent IO Libraries Suite
Online Help for details.

VXI Device Types

When using GPIB-VXI or VXI interfaces to directly access the VXI
backplane (in the VXI mainframe), you must know whether you are
programming a message-based or a register-based VXI device
(instrument).

A message-based VXI device has its own processor that allows it to
interpret high-level commands such as Standard Commands for

Programmable Instruments (SCPI). When using VISA, you can place
the SCPI command within your VISA output function call. Then, the
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message-based device interprets the SCPI command. In this case you
can use the VISA formatted I/O or non-formatted I/O functions and
program the message-based device as you would a GPIB device.

However, if the message-based device has shared memory, you can
access the device's shared memory by doing register peeks and pokes.
VISA provides two different methods you can use to program directly to
the registers: high-level memory functions or low-level memory
functions.

A register-based VXI device typically does not have a processor to
interpret high-level commands. Therefore, the device must be
programmed with register peeks and pokes directly to the device's
registers. VISA provides two different methods you can use to program
register-based devices: high-level memory functions or low-level
memory functions.

GPIB Interfaces Overview

Agilent VISA User’s Guide

As shown in the following figure, a typical GPIB interface consists of a
Windows PC with one or more GPIB cards (PCI and/or ISA) cards
installed in the PC, and one or more GPIB instruments connected to the
GPIB cards via GPIB cable. I/O communication between the PC and the
instruments is via the GPIB cards and the GPIB cable. The following
figure shows GPIB instruments at addresses 3 and 5.
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/ | GPIB Interface (82350 PCI GPIB Cards) | \
Windows PC GPIB Cable GPIB Instruments
5
82350 GPIB Card #1 } 3
‘ 82350 GPIB Card #2 1 3

2 /

Example: GPIB (82350) Interface

The GPIB interface system in the following figure consists of a
Windows PC with two 82350 GPIB cards connected to three GPIB
instruments via GPIB cables. For this system, Agilent Connection
Expert has been used to assign GPIB card #1 a VISA name of GPIB0
and to assign GPIB card #2 a VISA name of GPIB1. VISA addressing
is as shown in the figure.
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GPIB Interface (82350 PCI GPIB Cards)

Interface VISA Names

VISA Name

"GPIBO"

"GPIB1"

Windows PC GPIB Cable

GPIB Instruments

‘ 82350 GPIB Card #1 |

‘ 82350 GPIB Card #2 1

~

VISA Addressing

viOpen (... "GPIB0::5::INSTR"...)
viOpen (... "GPIBO0::3::INSTR"...)

Open |0 path to GPIB instrument at address 5 using 82350 Card #1
Open |0 path to GPIB instrument at address 3 using 82350 Card #1
K viOpen (... "GPIB1::3:INSTR"...)  Open IO path to GPIB instrument at address 3 using 82350 Card #2 /

Agilent VISA User’s Guide
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VXI Interfaces Overview

As shown in the following figure, a typical VXI (E8491) interface

consists of an E8491 PC Card in a Windows PC that is connected to an
E8491B IEEE-1394 Module in a VXI mainframe via an IEEE-1394 to

VXI cable. The VXI mainframe also includes one or more VXI

instruments.

/ VXI (E8491) Interfaces

Windows PC |IEEE-1394
to VXI

VXI Mainframe

W=©hrhoom

E8491 PC Card

=
S~ ~0 3 —

-~ ~0 35 —

~

/

Example: VXI (E8491B) Interfaces

The VXI interface system in the following figure consists of a Windows
PC with an E8491 PC card that connects to an E8491B IEEE-1394 to

VXI Module in a VXI Mainframe. For this system, the three VXI
instruments shown have logical addresses 8, 16, and 24. The

Connection Expert utility has been used to assign the E8491 PC card a

VISA name of VXIO0. VISA addressing is as shown in the figure.

For information on the E8491B module, see the Agilent E8491B User's
Guide. For information on VXI instruments, see the applicable VXI

instrument User s Guide.
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~

E8491 PC Card and E8491 |IEEE-1394 to VXI Module

VXl Interface (E8491B IEEE-1394 to VXI Module)
Interface VISA Name Windows PC IEEE-1394 to VXI VXI Mainframe
\Y \Y \Y
X X X
E | I |
2 | |
VISA Name 9 n n n
1 s s s
"VXI0" E8491 PC Card B t t t
r r r
LA8 | LA24 LA 16
VISA Addressing
viOpen (... "VXI0::24::INSTR"...) Open |0 path to VXI instrument at logical address 24 using

/

GPIB-VXI Interfaces Overview

Agilent VISA User’s Guide

As shown in the following figure, a typical GPIB-VXI interface consists
of a GPIB card (82350 or equivalent) in a Windows PC that is
connected via a GPIB cable to an E1406A Command Module. The

E1406A sends commands to the VXI instruments in a VXI mainframe.
There is no direct access to the VXI backplane from the PC.
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For a GPIB-VXI interface, VISA uses a DLL supplied by the Command
Module vendor to translate the VISA VXI calls to Command Module
commands that are vendor-specific. The DLL required for Agilent
Command Modules is installed by the Agilent 10 Libraries Suite
installer. This DLL is installed by default when Agilent VISA is
installed.

GPIB-VXI (E1406A) Interfaces \
Windows PC GPIB VXI Mainframe
\Y \% \%
X X X
E | | |
1
g | | |
n n n
GPIB Card 6 s s s
A t t t
r r r

/

Example: GPIB-VXI (E1406A) Interface

The GPIB-VXI interface system in the following figure consists of a
Windows PC with an Agilent 82350 GPIB card that connects to an
E1406A command module in a VXI mainframe. The VXI mainframe
includes one or more VXI instruments.

When Agilent IO Libraries Suite was installed, a GPIB-VXI driver with
GPIB address 9 was also installed, and the E1406A was configured for
primary address 9 and logical address (LA) 0. The three VXI
instruments shown have logical addresses 8, 16, and 24.
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The Connection Expert utility has been used to assign the GPIB-VXI
driver a VISA name of GPIB-VXI0 and to assign the 82350 GPIB card
a VISA name of GPIB0. VISA addressing is as shown in the figure.

For information on the E1406 A Command Module, see the Agilent
E14064 Command Module User s Guide. For information on VXI
instruments, see the applicable instrument’s User § Guide.

/ GPIB-VXI Interface (E1406A Command Module) \
Interface VISA Name Windows PC VXI Mainframe
VISA Name \ \% \%
— — — _| X X X
"GPIB-VXIO" | GPIB VXI Driver ) E | | |
GPIB Address 9 Primary
— _— Address9 | 1 I | I
4
I 0 n n n
6 s s s
"GPIBO" 82350 GPIB Card A t t t
GPIB r r r
LAO | LA8 | LA24 LA 16
VISA Addressing
viOpen (... "GPIB-VXI0::24:INSTR"...) ~ Open |0 path to VXI instrument at logical address 24 using
82350 GPIB Card and E1406A VXI Command Module at

K GPIB primary address 9 /
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High-level memory functions allow you to access memory on the
interface through simple function calls. There is no need to map
memory to a window. Instead, when high-level memory functions are
used, memory mapping and direct register access are automatically
done.

The trade-off, however, is speed. High-level memory functions are
easier to use. However, since these functions encompass mapping of
memory space and direct register access, the associated overhead slows
program execution time. If speed is required, use the low-level memory
functions discussed in “Using Low-Level Memory Functions” on

page 106.

Programming the Registers

High-level memory functions include the viln and viOut functions for
transferring 8-, 16-, or 32-bit values, as well as the viMoveln and
viMoveOut functions for transferring 8-, 16-, or 32-bit blocks of data
into or out of local memory. You can therefore program using 8-, 16-, or
32-bit transfers.

High-Level Memory Functions

This table summarizes the high-level memory functions.

Table 25 Summary of High-Level Memory Functions

Function Description

viln8 (vi, space, offset, val8) ; Reads 8 bits of data from the specified
offset.

viln16 (vi, space, offset, vall6); Reads 16 bits of data from the specified
offset.

viln32 (vi, space, offset, val32); Reads 32 bits of data from the specified
offset.

viOut8 (vi, space, offset, val8);  Writes 8 bits of data to the specified
offset.
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Table 25 Summary of High-Level Memory Functions

viOutl6 (vi, space, offset, Writes 16 bits of data to the specified
vall6) ; offset.

viOut32 (vi, space, offset, Writes 32 bits of data to the specified
val32); offset.

viMoveln8(vi, space, offset, Moves an 8-bit block of data from the
length, buf8); specified offset to local memory.
viMoveln16 (vi, space, offset, Moves a 16-bit block of data from the
length, buf16); specified offset to local memory.
viMoveln32(vi, space, offset, Moves a 32-bit block of data from the
length, buf32); specified offset to local memory.

viMoveOQut8(vi, space, offset, Moves an 8-bit block of data from local
length, buf8) ; memory to the specified offset.

viMoveOutl6 (vi, space, offset, Moves a 16-bit block of data from local
length, buf16); memory to the specified offset.

viMoveOut32 (vi, space, offset, Moves a 32-bit block of data from local
length, buf32); memory to the specified offset.

Using viln and viOut

When using the viln and viOut high-level memory functions to
program to the device registers, all you need to specify is the session
identifier, address space, and the offset of the register. Memory mapping
is done for you. For example, in this function:

viIn32 (vi, space, offset, val32);

vi is the session identifier and offset is used to indicate the offset of the
memory to be mapped. offset is relative to the location of this device's
memory in the given address space. The space parameter determines
which memory location to map the space. Valid space values are:

* VI_A16_SPACE - Maps in VXI/MXI A16 address space
* VI_A24 SPACE - Maps in VXI/MXI A24 address space
* VI_A32 SPACE - Maps in VXI/MXI A32 address space
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The val32 parameter is a pointer to where the data read will be stored. If
instead you write to the registers via the viOut32 function, the val32
parameter is a pointer to the data to write to the specified registers. If the
device specified by vi does not have memory in the specified address
space, an error is returned. The following code sample uses viln16.

ViSession defaultRM, vi;
ViUIntle value;

viOpenDefaultRM (&&defaultRM) ;

viOpen (defaultRM, "VXI::24", VI NULL, VI NULL,
&vi) ;

viInlé(vi, VI Al6 SPACE, 0x100, &value);

Using viMoveInand viMoveOut

You can also use the viMoveln and viMoveQut high-level memory
functions to move blocks of data to or from local memory. Specifically,
the viMoveln function moves an 8-, 16-, or 32-bit block of data from
the specified offset to local memory, and the viMoveOut functions
moves an 8-, 16-, or 32-bit block of data from local memory to the
specified offset. Again, the memory mapping is done for you.

For example, in this function:
viMoveIn32 (vi, space, offset, length, buf32);

vi is the session identifier and offset is used to indicate the offset of the
memory to be mapped. offset is relative to the location of this device's
memory in the given address space. The space parameter determines
which memory location to map the space and the length parameter
specifies the number of elements to transfer (8-, 16-, or 32-bits).

The buf32 parameter is a pointer to where the data read will be stored. If
instead you write to the registers via the viMoveOut32 function, the
buf32 parameter is a pointer to the data to write to the specified
registers.

High-Level Memory Functions: Sample Programs

Two sample programs follow that use the high-level memory functions
to read the ID and Device Type registers of a device at the VXI logical
address 24. The contents of the registers are then printed out.
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The first program uses the VXI interface; the second program accesses
the backplane with the GPIB-VXI interface. These two programs are
identical except for the string passed to viOpen.

Sample: Using VXI Interface (High-Level) Memory
Functions

This program uses high-level memory functions and the VXI interface
to read the ID and Device Type registers of a device at VXI0::24.

/* vxihl.c

This example program uses the high-level memory
functions to read the id and device type
registers of the device at VXIO::24. Change this
address if necessary. The register contents are
then displayed.*/

#include <visa.h>
#include <stdlib.h>
#include <stdio.h>

void main () {

ViSession defaultRM, dmm;
unsigned short id reg, devtype reg;

/* Open session to VXI device at address 24 */
viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM, "VXIO::24::INSTR", VI NULL,
VI_NULL, &dmm);

/* Read instrument id register contents */
viInl6 (dmm, VI Al6 SPACE, 0x00, &id regqg);

/* Read device type register contents */
viInl6 (dmm, VI Al6 SPACE, 0x02,
&devtype reg);

/* Print results */

printf ("ID Register = 0x%4X\n", id req);
printf ("Device Type Register = 0x%4X\n",
devtype req);
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/* Close sessions */
viClose (dmm) ;
viClose (defaultRM) ;

Sample: Using GPIB-VXI Interface (High-Level) Memory
Functions

This program uses high-level memory functions and the GPIB-VXI
interface to read the ID and Device Type registers of a device at
GPIB-VXI0::24.

/*gpibvxih.c

This example program uses the high-level memory
functions to read the id and device type
registers of the device at GPIB-VXIO::24. Change
this address if necessary. The register
contents are then displayed.*/

#include <visa.h>
#include <stdlib.h>
#include <stdio.h>

void main ()

{
ViSession defaultRM, dmm;

unsigned short id reg, devtype reg;

/* Open session to VXI device at address 24 */
viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM, "GPIB-VXIO::24::INSTR",

VI NULL,VI NULL, &dmm);

/* Read instrument id register contents */
viInl6 (dmm, VI Al6 SPACE, 0x00, &id req);

/* Read device type register contents */

viInl6 (dmm, VI Al6 SPACE, 0x02,
&devtype req);
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/* Print results */

printf ("ID Register = 0x%4X\n", id reqg);
printf ("Device Type Register = 0x%4X\n",
devtype regq);

/* Close sessions */
viClose (dmm) ;
viClose (defaultRM) ;

}

4
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Low-level memory functions allow direct access to memory on the
interface just as do high-level memory functions. However, with
low-level memory function calls, you must map a range of addresses
and directly access the registers with low-level memory functions, such
as viPeek32 and viPoke32.

There is more programming effort required when using low-level
memory functions. However, the program execution speed can increase.
Additionally, to increase program execution speed, the low-level
memory functions do not return error codes.

Programming the Registers

When using the low-level memory functions for direct register access,
you must first map a range of addresses using the viMapAddress
function. Next, you can send a series of peeks and pokes using the
viPeek and viPoke low-level memory functions. Then, you must free
the address window using the viUnmapAddress function. A process
you could use is:

1 Map memory space using viMapAddress.

2 Read and write to the register's contents using viPeek32 and
viPoke32.

3 Unmap the memory space using viUnmapAddress.

Low-Level Memory Functions

You can program the registers using low-level functions for 8-, 16-, or
32-bit transfers. This table summarizes the low-level memory functions.

Table 26 Summary of Low-Level Memory Functions

Function Description

viMapAddress(vi, Maps the specified memory space.
mapSpace, mapBase,

mapSize, access, suggested,

address);

viPeek8(vi, addr, val8); Reads 8 bits of data from address specified.
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Table 26 Summary of Low-Level Memory Functions (continued)

viPeek16(vi, addr, vall6), Reads 16 bits of data from address specified.
viPeek32(vi, addr, val32), Reads 32 bits of data from address specified.
viPoke8(vi, addr, vals8); Writes 8 bits of data to address specified.
viPokel6(vi, addr, vall6); Writes 16 bits of data to address specified.
viPoke32(vi, addr, val32); Writes 32 bits of data to address specified.

viUnmapAddress(vi); Unmaps memory space previously mapped.

Mapping Memory Space

When using VISA to access the device's registers, you must map
memory space into your process space. For a given session, you can
have only one map at a time. To map space into your process, use the
VISA viMapAddress function:

viMapAddress (vi, mapSpace, mapBase, mapSize,
access, suggested, address);

This function maps space for the device specified by the vi session.
mapBase, mapSize, and suggested are used to indicate the offset of the
memory to be mapped, amount of memory to map, and a suggested
starting location, respectively. mapSpace determines which memory
location to map the space. The following are valid mapSpace choices:

VI_A16_SPACE - Maps in VXI/MXI A16 address space
VI_A24 SPACE - Maps in VXI/MXI A24 address space
VI_A32 SPACE - Maps in VXI/MXI A32 address space

A pointer to the address space where the memory was mapped is
returned in the address parameter. If the device specified by vi does not
have memory in the specified address space, an error is returned. Some
sample viMapAddress function calls follow.

/* Maps to A32 address space */
viMapAddress (vi, VI _A32 SPACE, 0x000, 0x100,
VI_FALSE,

VI NULL, &address) ;
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/* Maps to A24 address space */
viMapAddress (vi, VI_A24 SPACE, 0x00, 0x80,
VI_FALSE,

VI NULL, &address) ;

Reading and Writing to Device Registers

When you have mapped the memory space, use the VISA low-level
memory functions to access the device's registers. First, determine
which device register you need to access. Then, you need to know the
register's offset. See the applicable instrument’s user manual for a
description of the registers and register locations. You can then use this
information and the VISA low-level functions to access the device
registers.

Sample: Using viPeek16
A code sample using viPeek16 follows.

ViSession defaultRM, vi;
ViUuIntle value;
ViAddr address;
ViUuIntle value;

viOpenDefaultRM (&&defaultRM) ;
viOpen (defaultRM, "VXI::24::INSTR", VI NULL,
VI NULL,

&vi) ;
viMapAddress (vi, VI Al6 SPACE, 0x00, 0x04,
VI FALSE,

VI NULL, &address);
viPeekl6 (vi, addr, &value)

Unmapping Memory Space

Make sure you use the viUnmapAddress function to unmap the
memory space when it is no longer needed. Unmapping memory space
makes the window available for the system to reallocate.
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Low-Level Memory Functions: Code Samples
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Two sample programs follow that use the low-level memory functions
to read the ID and Device Type registers of the device at VXI logical
address 24. The contents of the registers are then printed out. The first
program uses the VXI interface and the second program uses the
GPIB-VXI interface to access the VXI backplane. These two programs
are identical except for the string passed to viOpen.

Sample: Using the VXI Interface (Low-Level) Memory
Functions

This program uses low-level memory functions and the VXI interface to
read the ID and Device Type registers of a device at VXI0::24.

/*vxill.c

This example program uses the low-level memory
functions to read the id and device type
registers of the device at VXI0O::24. Change this
address if necessary. The register contents are
then displayed.*/

#include <visa.h>
#include <stdlib.h>
#include <stdio.h>

void main () {

ViSession defaultRM, dmm;
ViAddr address;
unsigned short id reg, devtype reg;

/* Open session to VXI device at address 24 */

viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM, "VXIO::24::INSTR", VI NULL,
VI NULL, &dmm);

/* Map into memory space */
viMapAddress (dmm, VI Al6 SPACE, 0x00, 0x10,
VI FALSE,VI NULL, &address);

/* Read instrument id register contents */
viPeekl6 (dmm, address, &id reg);
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/* Read device type register contents */
/* ViAddr is defined as a void so we must cast
/* it to something else to do pointer
arithmetic */
viPeekl6 (dmm, (ViAddr) ((ViUIntlo *)address +
0x01),
&devtype req);

/* Unmap memory space */
viUnmapAddress (dmm) ;

/* Print results */

printf ("ID Register = 0x%4X\n", id reg);

printf ("Device Type Register = 0x%4X\n",
devtype regq);

/* Close sessions */
viClose (dmm) ;
viClose (defaultRM) ;
}

Sample: Using the GPIB-VXI Interface (Low-Level) Memory
Functions

This program uses low-level memory functions and the GPIB-VXI
interface to read the ID and Device Type registers of a device at
GPIB-VXI0::24.

/*gpibvxil.c

This example program uses the low-level memory
functions to read the id and device type
registers of the device at GPIB-VXIO::24. Change
this address if necessary. Register contents are
then displayed.*/

#include <visa.h>
#include <stdlib.h>
#include <stdio.h>

void main () {

ViSession defaultRM, dmm;
ViAddr address;
unsigned short id reg, devtype reg;
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/* Open session to VXI device at address 24 */
viOpenDefaultRM (&defaultRM) ;
viOpen (defaultRM, "GPIB-VXIO::24::INSTR",
VI_NULL,
VI NULL, &dmm) ;

/* Map into memory space */
viMapAddress (dmm, VI Al6é SPACE, 0x00, 0x10,
VI FALSE,

VI NULL, &address);

/* Read instrument id register contents */
viPeekl6 (dmm, address, &id regq);

/* Read device type register contents */

/* ViAddr is defined as a void so we must
cast it to something else to do pointer
arithmetic */

viPeekl6 (dmm, (ViAddr) ((ViUIntlo *)address +
0x01),

&devtype regqg);

/* Unmap memory space */
viUnmapAddress (dmm) ;

/* Print results */

printf ("ID Register = 0x%4X\n", id req);

printf ("Device Type Register = 0x%4X\n",
devtype regq);

/* Close sessions */
viClose (dmm) ;
viClose (defaultRM) ;

}
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VISA supports three different memory I/0O methods for accessing
memory on the VXI backplane, as shown. All three of these access
methods can be used to read and write VXI memory in the A16, A24,
and A32 address spaces. The best method to use depends on the VISA
program characteristics.

e Low-level viPeek/viPoke
viMapAddress
viUnmapAddress
viPeek8, viPeekl16, viPeek32
viPoke8, viPokel6, viPoke32

» High-level viln/viOut
viln8, viln16, viln32
viOut8, viOutl6, viOut32

* High-level viMoveln/viMoveOut
viMoveln8, viMoveln16, viMoveln32

viMoveOut8, viMoveOutl6, viMoveOut32

Using Low-Level viPeek/viPoke

Low-level viPeek/viPoke is the most efficient in programs that require
repeated access to different addresses in the same memory space.

The advantages of low-level viPeek/viPoke are:

¢ Individual viPeek/viPoke calls are faster than viln/viOut or
viMoveln/viMoveOut calls.

* Memory pointers may be directly de-referenced in some cases for the
lowest possible overhead.

The disadvantages of low-level viPeek/viPoke are:

e A viMapAddress call is required to set up mapping before
viPeek/viPoke can be used.

¢ viPeek/viPoke calls do not return status codes.
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* Only one active viMapAddress is allowed per vi session.

e There may be a limit to the number of simultaneous active
viMapAddress calls per process or system.

Using High-Level viln/viOut

High-level viln/viOut calls are best in situations where a few widely
scattered memory accesses are required and speed is not a major
consideration.

The advantages of high-level viln/viOut are:
e It is the simplest method to implement.
e There is no limit on the number of active maps.

e Al6, A24, and A32 memory access can be mixed in a single vi
session.

The disadvantage of high-level viln/viOut calls is that they are slower
than viPeek/viPoke.

Using High-Level viMoveln/viMoveQOut

Agilent VISA User’s Guide

High-level viMoveln/viMoveOut calls provide the highest possible
performance for transferring blocks of data to or from the VXI
backplane. Although these calls have higher initial overhead than the
viPeek/viPoke calls, they are optimized on each platform to provide the
fastest possible transfer rate for large blocks of data.

For small blocks, the overhead associated with viMoveln/viMoveOut
may actually make these calls longer than an equivalent loop of
viln/viOut calls. The block size at which viMoveln/viMoveOut
becomes faster depends on the particular platform and processor speed.
The advantages of high-level viMoveln/viMoveQOut are:

* They are simple to use.

e There is no limit on number of active maps.

* Al6, A24, and A32 memory access can be mixed in a single vi
session.

» They provide the best performance when transferring large blocks of
data.

e They support both block and FIFO mode.
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The disadvantage of viMoveln/viMoveQOut calls is that they have
higher initial overhead than viPeek/viPoke.

Sample: Using VXI Memory 1/0

This program demonstrates using various types of VXI memory I/0.

/* memio.c
This example program demonstrates the use of
various memory I/0 methods in VISA. */

#include <visa.h>
#include <stdlib.h>
#include <stdio.h>

#define VXI INST "VXIO::24::INSTR"

void main () {
ViSession defaultRM, vi;
ViAddr address;
ViuIntlé accessMode;

unsigned short *memPtrl6;
unsigned short id reg;
unsigned short devtype reg;
unsigned short memArray[2];

/*Open default resource manager and session
to instr*/

viOpenDefaultRM (&defaultRM) ;

viOpen defaultRM, VXI INST, VI NULL,VI NULL,
&vi) ;

Low level memory I/0 = viPeekl6 = direct
memory dereference (when allowed)

*/

/* Map into memory space */

viMapAddress (vi, VI _Al6 SPACE, 0x00, 0x10,
VI FALSE,VI NULL, &address);
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Read instrument id register contents */
viPeekl6 (vi, address, &id reg);

/* Read device type register contents
ViAddr is defined as a (void *) so we must
cast it to something else in order to do
pointer arithmetic. */

viPeekl6 (vi, (ViAddr) ((ViUIntl6 *)address +
0x01), &devtype reqg);

/* Print results */

printf (" viPeekl6: ID Register = 0x%4X\n",
id reqg);
printf (" viPeekl6: Device Type Register =

0x%$4X\n",devtype req);

/* Use direct memory dereferencing if
supported */

viGetAttribute( vi, VI _ATTR WIN ACCESS,
&accessMode ) ;

if ( accessMode == VI DEREF ADDR ) {

/* assign pointer to variable of correct
type */
memPtrl6 = (unsigned short *)address;

/* do the actual memory reads */
id reg = *memPtrl6;
devtype reg = * (memPtrl6+1);

/* Print results */

printf ("dereference: ID Register =
0x%4X\n", id regqg);
printf ("dereference: Device Type Register
=0x%4X\n", devtype regq);

}
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/* Unmap memory space */
viUnmapAddress (vi);

/* Read instrument id register contents */
viInlé (vi, VI Alé SPACE, 0x00, &&id reg);

/* Read device type register contents */
viInlé (vi, VI Alé SPACE, 0x02, &devtype reqg);

/* Print results */

printf (" wviInl6: ID Register = 0x%4X\n",
id regqg);
printf (" wviInlé: Device Type Register =

0x%$4X\n", devtype reg);

High Level block memory I/0 = viMovelInlé6

The viMoveIn/viMoveOut commands do both block
read/write and FIFO read write. These commands
offer the best performance for reading and
writing large data blocks on the VXI backplane.
For this example we are only moving 2 words at a
time. Normally, these functions would be used to
move much larger blocks of data.

If the value of VI ATTR SRC INCREMENT is 1 (the
default),viMoveIn does a block read. If the
value of VI _ATTR SRC_INCREMENT is 0, viMoveln
does a FIFO read.

If the value of VI ATTR DEST INCREMENT is 1 (the
default),viMoveOut does a block write. If the
value of VI ATTR DEST INCREMENT is 0, viMoveOut
does a FIFO write.
e * /
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/* Demonstrate block read.
Read instrument id register and device type
register into an array.*/

viMoveInl6 (vi, VI Al6 SPACE, 0x00, 2,
memArray) ;

/* Print results */

printf (" viMoveInl6: ID Register = 0x%4X\n",
memArray[0]) ;
printf (" viMoveInlé6: Device Type Register =

0x%4X\n", memArray[l]);
/* Demonstrate FIFO read.

First set the source increment to 0 so we will
repetitively read from the same memory
location.*/

viSetAttribute( vi, VI ATTR SRC_ INCREMENT, 0
);

/* Do a FIFO read of the Id Register */
viMoveInl6é (vi, VI _Al6 SPACE, 0x00, 2,
memArray) ;

/* Print results */
printf (" viMoveInlé6: 1 ID Register
0x%4X\n",

memArray[0]);
printf (" viMoveInlé6: 2 ID Register
0x%4X\n",

memArrayl[l]);

/* Close sessions */
viClose (vi);
viClose (defaultRM); }
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Using the Memory Access Resource
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For VISA 1.1 and later, the Memory Access (MEMACC) resource type
has been added to VXI and GPIB-VXI. VXI::MEMACC and
GPIB-VXI::MEMACC allow access to all of the A16, A24, and A32
memory by providing the controller with access to arbitrary registers or
memory addresses on memory-mapped buses.

The MEMACC resource, like any other resource, starts with the basic
operations and attributes of other VISA resources. For example,
modifying the state of an attribute is done via the operation
viSetAttribute (see VISA Resource Classes in the VISA Online Help for
details).

Memory I/O Services

Memory 1/O services include high-level memory I/O services and
low-level memory 1/O services.

High-Level Memory I/O Services

High-level memory I/O services allow register-level access to the
interfaces that support direct memory access, such as the VXIbus,
VMEbus, MXIbus, or even VME or VXI memory through a system
controlled by a GPIB-VXI controller. A resource exists for each
interface to which the controller has access.

You can access memory on the interface bus through operations such as
viln16 and viOut16. These operations encapsulate the map/unmap and
peek/poke operations found in the low-level service. There is no need to
explicitly map the memory to a window.

Low-Level Memory I/O Services

Low-level memory I/O services also allow register-level access to the
interfaces that support direct memory access. Before an application can
use the low-level service on the interface bus, it must map a range of
addresses using the operation viMapAddress.
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Although the resource handles the allocation and operation of the
window, the programmer must free the window via viUnMapAddress
when finished. This makes the window available for the system to
reallocate.

Sample: MEMACC Resource Program

This program demonstrates one way to use the MEMACC resource to
open the entire VXI A16 memory and then calculate an offset to address
a specific device.

/* peekl6.c */
#include <stdio.h>
#include <stdlib.h>
#include <visa.h>

#define EXIT1
#define NO EXIT 0

/* This function simplifies checking for VISA
errors. */
void checkError( ViSession vi, ViStatus status,
char
*errStr,int doexit) {
char buf[256];
if (status >= VI SUCCESS)
return;
buf[0] = 0;
viStatusDesc( vi, status, buf );
printf ( "ERROR 0x%1x (%s)\n ’%$s’\n", status,
errStr,
buf );
if ( doexit == EXIT )
exit (1 );
}

void main () {
ViSession drm;
ViSession vi;
ViUIntlé6inDatal6 = 0;
ViUIntlépeekDatal6 = 0;
ViUInt8*addr;
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ViUIntlo6*addrlo;
ViStatusstatus;
ViUIntlooffset;

status = viOpenDefaultRM ( &drm );
checkError( 0, status, "viOpenDefaultRM",
EXIT );

/* Open a session to the VXI MEMACC Resource*/

status = viOpen( drm, "vxiO::memacc",
VI NULL, VI NULL,
&vi ) ;

checkError (0, status, "viOpen", EXIT );

/* Calculate the Al6 offset of the VXI
REgisters for
the device at VXI logical address 8. */
offset = 0xc000 + 64 * 8;

/* Open a map to all of Al6 memory space. */
status =
viMapAddress (vi,VI_Al6 SPACE,0,0x10000,
VI _FALSE, 0, (ViPAddr) (&addr));
checkError ( vi, status, "viMapAddress", EXIT

);

/* Offset the address pointer returned from
viMapAddress for use with viPeekl6. */
addrle = (ViUIntleée *) (addr + offset);

/* Peek the contents of the card’s ID register
(offset
0 from card’s base address. Note that
viPeek does
not return a status code. */
viPeekl6( vi, addrlé, &peekDatal6 );

/* Now use viInl6 and read the contents of the
same
register */
status = viInlé6(vi, VI Al6 SPACE,
ViBusAddress)offset, &inDatal6 );
checkError (vi, status, "viInlée", NO EXIT );
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/* Print the results. */
printf( "inDatal6 : 0x%04hx\n", inDatal6 );

printf ( "peekDatal6: ox%$04hx\n", peekDatal6

viClose ( vi );

viClose (drm );

}

MEMACC Attribute Descriptions

Generic MEMACC Attributes

The following read-only attributes (VI ATTR TMO_VALUE is
read/write) provide general interface information.

Table 27 Attributes That Provide General Interface Information

4

Attribute

Description

VI_ATTR_INTF_TYPE
VI_ATTR_INTF_NUM
VI_ATTR_TMO_VALUE

VI_ATTR_INTF_INST NA
ME

VI_ATTR_DMA_ALLOW _
EN

Interface type of the given session.
Board number for the given interface.

Minimum timeout value to use, in
milliseconds. A timeout value of
VI_TMO_IMMEDIATE means operation
should never wait for the device to respond.
A timeout value of VI. TMO_INFINITE
disables the timeout mechanism.

Human-readable text describing the given
interface.

Specifies whether I/O accesses should use
DMA (VI_TRUE) or Programmed 1/O
(VI_FALSE).
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VXI and GPIB-VXI Specific MEMACC Attributes

The following attributes, most of which are read/write, provide memory
window control information.

Table 28 Attributes That Provide Memory Window Control

Information
Attribute Description
VI_ATTR VXI LA Logical address of the local controller.

VI_ATTR _SRC_INCREMENT Used in viMovelnxx operation to specify
how much the source offset is to be
incremented after every transfer. The
default value is 1 and the viMoveIlnxx
operation moves from consecutive
elements.

If this attribute is set to 0, the viMovelnxx
operation will always read from the same
clement, essentially treating the source as a
FIFO register.

VI_ATTR DEST INCREMEN Used in viMoveOutxx operation to specify

T how much the destination offset is to be
incremented after every transfer. The
default value is 1 and the viMoveOutxx
operation moves into consecutive elements.

If this attribute is set to 0, the
viMoveOutxx operation will always write
to the same element, essentially treating the
destination as a FIFO register.

VI_ATTR WIN_ACCESS Specifies modes in which the current
window may be addressed: not currently
mapped, through the viPeekxx or viPokexx
operations only, or through operations
and/or by directly de-referencing the
address parameter as a pointer.

VI_ATTR_WIN BASE ADD  Base address of the interface bus to which
R this window is mapped.

VI_ATTR WIN _SIZE Size of the region mapped to this window.
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Table 28 Attributes That Provide Memory Window Control
Information

VI_ATTR _SRC BYTE ORDE Specifies the byte order used in high-level

R access operations, such as vilnxx and
viMovelnxx, when reading from the
source.

VI_ATTR DEST BYTE ORD Specifies the byte order used in high level

ER access operations, such as viQutxx and
viMoveOutxx, when writing to the
destination.

VI_ATTR_WIN BYTE ORD  Specifies the byte order used in low-level

ER access operations, such as viMapAdadress,
viPeekxx, and viPokexx, when accessing
the mapped window.

VI_ATTR _SRC_ACCESS PRI Specifies the address modifier used in

v high-level access operations, such as
vilnxx and viMovelnxx, when reading
from the source.

VI_ATTR DEST ACCESS P  Specifies the address modifier used in

RIV high-level access operations such as
viOQutxx and viMoveOutxx, when writing
to destination.

VI_ATTR_WIN_ACCESS PR  Specifies the address modifier used in

v low-level access operations, such as
viMapAddress, viPeekxx, and viPokexx,
when accessing the mapped window.

GPIB-VXI Specific MEMACC Attributes

The following read-only attributes provide specific address information
about GPIB hardware.

Table 29 Attributes that Provide Specific Address Information

Attribute Description

VI _ATTR_INTF_PARENT NUM Board number of the GPIB board to
which the GPIB-VXI is attached.
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Table 29 Attributes that Provide Specific Address Information

VI _ATTR_GPIB PRIMARY ADD  Primary address of the GPIB-VXI
R controller used by the session.

VI _ATTR_GPIB_SECONDARY A  Secondary address of the GPIB-VXI
DDR controller used by the session.

MEMACC Resource Event Attribute

The following read-only events provide notification that an
asynchronous operation has completed.

Table 30 Events Providing Notification About Asynchronous
Operations

Attribute Description

VI ATTR_ EVENT T  Unique logical identifier of the event.
YPE

VI _ATTR_STATUS Return code of the asynchronous I/O operation that
has completed.

VI _ATTR JOB_ID Job ID of the asynchronous I/O operation that has
completed.

VI _ATTR_BUFFER Address of a buffer used in an asynchronous
operation.

VI ATTR_RET COU  Actual number of elements that were
NT asynchronously transferred.
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Using VXI-Specific Attributes

VXI-specific attributes can be useful to determine the state of your VXI
system. Attributes are read-only and read/write. Read-only attributes
specify things such as the logical address of the VXI device and
information about where your VXI device is mapped. This section
shows how you might use some of the VXI-specific attributes. See VISA
Resource Classes in the VISA Online Help for information on VISA
attributes.

Using the Map Address as a Pointer

Agilent VISA User’s Guide

The VI ATTR_WIN_ ACCESS read-only attribute specifies how a
window can be accessed. You can access a mapped window with the
VISA low-level memory functions or with a C pointer if the address is
de-referenced. To determine how to access the window, read the
VI_ATTR_WIN_ACCESS attribute.

VI_ATTR_WIN_ACCESS Settings

The VI ATTR_WIN_ ACCESS read-only attribute can be set to one of
the following:

Table 31 Settings for the VI ATTR WIN_ACCESS Attribute

Setting Description

VI NMAPPED  Specifies that the window is not mapped.

VI_USE OPERS Specifies that the window is mapped and you can only use
the low-level memory functions to access the data.

VI DEREF_AD  Specifies that the window is mapped and has a

DR de-referenced address. In this case you can use the
low-level memory functions to access the data, or you can
use a C pointer. Using a de-referenced C pointer will
allow faster access to data.
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Sample: Determining Window Mapping

ViAddr address;
Vi UIntl6 access;
ViUIntl6 wvalue;

viMapAddress (vi, VI _Alé6 SPACE, 0x00, 0x04,
VI FALSE,
VI NULL, &address);
viGetAttribute (vi, VI _ATTR WIN ACCESS, &access);

If (access==VI USE OPERS) {
viPeekl6 (vi, (ViAddr) (((ViUIntleo *)address) +
4/sizeof (ViUINntle6)), &value)
}else if (access==VI DEREF ADDR) {
value=* ((ViUIntlo
*)address+4/sizeof (ViUIntl6)) ;
}else if (access==VI_ NMAPPED) {
return error;

Setting the VXI Trigger Line

The VI_ATTR _TRIG _ID attribute is used to set the VXI trigger line.
This attribute is listed under generic attributes and defaults to

VI _TRIG_SW (software trigger). To set one of the VXI trigger lines, set
the VI ATTR TRIG_ID attribute as follows:

viSetAttribute (vi, VI _ATTR TRIG_ID,
VI_TRIG_TTLO) ;
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The above function sets the VXI trigger line to TTL trigger line 0
(VI_TRIG_TTLO). The following are valid VXI trigger lines. (Panel In
is an Agilent extension of the VISA specification.)

Table 32 VXI Trigger Lines and Values

VXI Trigger VI_ATTR_TRIG_ID Value

Line

TTL O VI_TRIG _TTLO
TTL 1 VI_TRIG TTLI1
TTL 2 VI_TRIG _TTL2
TTL 3 VI _TRIG_TTL3
TTL 4 VI_TRIG TTL4
TTL 5 VI_TRIG_TTL5
TTL 6 VI_TRIG_TTL6
TTL 7 VI_TRIG _TTL7
ECLO VI _TRIG_ECLO
ECL 1 VI _TRIG _ECL1
Panel In VI_TRIG _PANEL IN

Once you set a VXI trigger line, you can set up an event handler to be
called when the trigger line fires. See “Using Events and Handlers” on
page 56 for more information on setting up an event handler. Once the
VI EVENT TRIG event is enabled, the VI ATTR TRIG ID becomes
aread only attribute and cannot be changed. You must set this attribute
prior to enabling event triggers.

The VI_ ATTR_TRIG_ID attribute can also be used by viAssertTrigger
function to assert software or hardware triggers. If VI ATTR TRIG_ID
is VI TRIG_SW, the device is sent a Word Serial Trigger command. If
the attribute is any other value, a hardware trigger is sent on the line
corresponding to the value of that attribute.
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Programming via LAN

This chapter provides guidelines for programming via a LAN (Local
Area Network). A LAN allows you to extend the control of
instrumentation beyond the limits of typical instrument interfaces.

The chapter contents are:

¢ LAN Interfaces Overview

¢ Communicating with LAN-Connected Devices

This chapter describes programming using the VISA TCPIP interface
type to communicate directly with a LAN-connected device, as well as
using a remote interface (also known as a LAN client) to emulate a
GPIB, serial (ASRL), or USB interface on the local machine to
communicate with a LAN-connected device.

See the Agilent 10 Libraries Suite Online Help for information on how
to start and stop the Remote IO Server software, and on how to create
and configure LAN interfaces and remote GPIB/USB/serial interfaces.

See the Connectivity Guide for detailed information on connecting
instruments to a LAN, and for a discussion of network protocols.
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LAN and Remote Interfaces Overview

This section provides an overview of LAN (Local Area Network)
interfaces. A LAN is a way to extend the control of instrumentation
beyond the limits of typical instrument interfaces. To communicate with
instruments over the LAN, you must first configure a LAN interface or
a remote GPIB, USB, or serial interface, using the Agilent Connection
Expert.

Direct LAN Connection versus Remote IO Server/Client
Connection

Some instruments support direct connection to the LAN. These
instruments include an RJ-45 or other standard LAN connector and
software support for operating as an independent device on the network.
Some of these instruments are Web-enabled, meaning that they host a
Web page which you can access over the LAN.

With the Agilent IO Libraries Suite, you can connect to instruments
across the LAN even if they do not have direct LAN capability, if they
are connected to gateways (such as the Agilent ES810A) or to another
PC running the Remote IO Server software.

Refer to the /O Libraries Suite and the Connectivity Guide for
information on connecting and configuring different types of LAN
instrument connections.

Remote 10 Server/Client Architecture

The Remote IO Server and Client software provided with Agilent IO
Libraries Suite allows instrumentation to be controlled over a LAN.
Using standard LAN connections, instruments can be controlled from
computers that do not have special interfaces for instrument control.

Client/Server Model

The IO Libraries Suite software uses the client/server model of
computing. Client/server computing refers to a model in which an
application (the client) does not perform all necessary tasks of the
application itself. Instead, the client makes requests of another
computing device (the remote I/O server) for certain services.
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As shown in the following figure, a remote I/O client (a Windows PC)
makes VISA requests over the network to a remote I/O server (such as a
Windows PC, an E5810 LAN/GPIB Gateway, or a Series 700 HP-UX
workstation).

Gateway Operation

The remote 1/O server is connected to the instrumentation or devices to
be controlled. Once the remote I/O server has completed the requested
operation on the instrument or device, the remote 1/O server sends a
reply to the client. This reply contains the requested data and status
information that indicates whether or not the operation was successful.
The remote I/O server acts as a gateway between the LAN software that
the client system supports and the instrument-specific interface that the
device supports.
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Addressing LAN-Connected Devices

VISA can communicate with LAN-connected devices in one of two
ways:
e TCPIP interface type

* Remote interface type (available only with Agilent IO Libraries
Suite)

Using the TCPIP Interface Type for LAN Access

Agilent VISA User’s Guide

VISA provides the TCPIP interface type to communicate with
LAN-connected devices. These can be devices connected directly to the
LAN, or they can be connected to the LAN through a LAN gateway
such as the Agilent E5S810 LAN/GPIB gateway or through Remote 10
Server software running on a remote computer with instruments
connected to it.

The format of a TCPIP VISA resource string is:

TCPIP[<board>]::<hostname>[::<LAN device
name>] [: : INSTR]

where:
e <board> = board number (default is 0)

e <hostname> = the hostname or IP address of the LAN device or
server

* <LAN device name> = the remote device name (case sensitive
with default name of inst0)

Using Connection Expert, you can configure a LAN interface to use
either the VXI-11 protocol or the SICL-LAN protocol. The protocol(s)
you will use depends upon the devices you are using and the protocol(s)
that they support.

The VXI-11 protocol constrains the LAN device name to be of the form
inst0, instl, ... for VXI-11.3 devices and gpib0,n, gpib1,n, ... for
VXI-11.2 (GPIB Emulation) devices.

The SICL-LAN protocol allows any valid SICL name for the LAN
device name. A valid SICL name must be a unique string of
alphanumeric characters, starting with a letter.
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Some examples of TCPIP resource strings follow.

Table 33 Example TCPIP Resource Strings

String

Description

TCPIPO::testMachine@agilent.com::gpib0,2::INST
R

TCPIP0::123.456.0.21::gpib0,2::INSTR

TCPIPO::myMachine::inst0::INSTR

TCPIP::myMachine

TCPIPO::testMachinel::COM1,488::INSTR

TCPIPO::myMachine::gpib0,2::INSTR

TCPIPO::myMachine::UsbDevicel::INSTR

A VXI-11.2 GPIB device at hostname
testMachine@agilent.com.

A VXI-11.2 GPIB device at a machine whose IP address is
123.456.0.21.

A VXI-11.3 LAN instrument at hostname myMachine.

A VXI-11.3 LAN instrument at hostname myMachine. Note that
default values for board = 0, LAN device name = inst0, and the
::INSTR resource class are used.

An RS-232 device connected to a LAN server or gateway at
hostname testMachinel. This device must use SICL-LAN
protocol since RS-232 devices are not supported by the VXI-11
protocol.

A GPIB device at hostname myMachine. This device must use
SICL-LAN protocol since gpib0,2 is not a valid remote name
with the VXI-11 protocol.

A USB device with a SICL alias of UsbDevicel connected to a
LAN server at hostname myMachine. Note that the SICL alias is
defined on the remote machine, not on the local machine.

Although the SICL and VISA alias names are normally the same,
if they are not, you must be sure to use the SICL alias and not the
VISA alias.

This device must use the SICL-LAN protocol since USB devices
are not supported by the VXI-11 protocol.
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Table 33 Example TCPIP Resource Strings

String

Description

TCPIPO::myMachine::usb0[2391::1031::SN_00123 A USB device with:

::0]::INSTR

Manufacture ID = 2391
Model Code = 1031

Serial Number ='SN_00123'
USBTMC Intfc #=0

connected to a LAN server at hostname myMachine.

This device must use SICL-LAN protocol since USB devices are
not supported by the VXI-11 protocol.

Agilent VISA User’s Guide

A LAN session to a remote interface provides the same VISA function
support as if the interface were local, except that VXI-specific functions
are not supported over LAN.

Addressing a Session Using the TCPIP Interface Type

This sample shows one way to open a device session with a GPIB
device at primary address 23 on a remote PC that is running a LAN
server. The hostname of the remote PC is myMachine. See Chapter 3,
“Programming with VISA”, for more information on addressing device
sessions.

ViSession defaultRM, vi;.

viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM,
"TCPIPO::myMachine::gpib0,23::INSTR", VI NULL,
VI _NULL, &vi);

viClose (vi) ;
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viClose (defaultRM) ;

Using a Remote Interface for LAN Access

Agilent VISA provides three types of VISA LAN Client interfaces,
implemented in Agilent IO Libraries Suite as remote interfaces:

¢ Remote serial interface (ASRL VISA LAN Client)
* Remote GPIB interface (GPIB VISA LAN Client)
* Remote USB interface (USB VISA LAN Client)

Remote interfaces are configured using Connection Expert; they
provide virtual GPIB, serial, or USB interfaces. They make it possible
to remotely access a LAN-connected device as if it were connected to a
local interface. If, for example, the GPIB2 interface is configured as a
remote GPIB interface, a program controlling the devices
GPIB2::5::INSTR and GPIB2::7::INSTR would not be aware of the
fact that these devices are actually connected via LAN and not to a
GPIB interface connected to the local machine.

See the Agilent 10 Libraries Suite Online Help for specific information
on configuring remote interfaces.

Remote Serial Interface (ASRL VISA LAN Client)

A remote serial interface can use only the SICL-LAN protocol. A
remote serial interface can be configured to use the serial port on the
Agilent E5S810 LAN/GPIB gateway or the serial ports on a PC running
the Remote 10 Server software.

Remote GPIB Interface (GPIB VISA LAN Client)

A remote GPIB interface can use both the VXI-11 and SICL-LAN
protocols. Typical uses for remote GPIB interfaces are with LAN/GPIB
gateways (e.g. Agilent E5810), PCs with GPIB interfaces that are
running a LAN server, and VXI-11.2 LAN-based instruments.

A remote GPIB interface can only be used to communicate with
VXI-11.2 (GPIB Emulation) devices. This is because the VISA GPIB
interface type requires a primary and (optionally) a secondary address
when communicating with a device. VXI-11.3 devices do not support
the concept of a primary address, so they cannot be accessed with a
remote GPIB interface.
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Remote USB Interface (USB VISA LAN Client)

A remote USB interface can use only the SICL-LAN protocol. It can
communicate with USB devices attached to a remote PC running the
Remote IO Server software.

Note that if you have defined a VISA alias for a USB device on the
remote I/O server, you must either define the same (or another) alias for
the remote USB device on the client PC, or use the full USB resource
string. Alias definitions are not shared between the remote 1/O server
and the client.

Addressing a Session Using a Remote Interface

In general, the rules to address a remote session are the same as to
address a local session. The only difference for a remote session is that
you use the VISA interface ID (provided during I/O configuration via
Connection Expert) that relates to the remote interface.

The following sample shows one way to open a device session with a
GPIB device at primary address 23 on a remote PC that is running
Remote IO Server software. A remote GPIB interface has been
configured at GPIB2 to communicate with that machine. See Chapter 3,
“Programming with VISA”, for more information on addressing device
sessions.

ViSession defaultRM, vi;.

viOpenDefaultRM (&defaultRM) ;

viOpen (defaultRM, "GPIB2::23::INSTR", VI NULL,
VI NULL, &vi);

viClose (vi) ;

viClose (defaultRM) ;
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6
Programming via USB

This chapter provides guidelines for VISA programming of USB
instruments that conform to USBTMC (Universal Serial Bus Test and
Measurement Class) and/or USBTMC-USB488 (Universal Serial Bus
Test and Measurement Class, Subclass USB488 Specification).

The chapter contents are:

¢ USB Interfaces Overview

* Communicating with a USB Instrument Using VISA
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Programming via USB

USB Interfaces Overview

140

USBTMC/USBTMC-USB488 instruments are detected and
automatically configured by Agilent VISA when they are plugged into
the computer. The Agilent 10 Libraries Suite Online Help describes the
USB instrument configuration process in more detail.

Do not confuse the Agilent 82357 USB/GPIB Interface with a
USBTMC device. The 82357 is automatically configured as a GPIB
interface, not as a USBTMC device, when it is plugged into the
computer. Only USBTMC/USBTMC-USB488 devices are configured
as USB devices by Agilent VISA.

Due to the complexity of the VISA USB resource string, a VISA alias
(simple name) is assigned to each USB instrument when it is plugged
into the computer. You can use either the alias or the full VISA resource
string when opening a VISA resource, but using the alias is
recommended because it is simpler and because it allows substitution of
USB instruments without the need to change the VISA program.

You can also create VISA aliases for other (non-USB) instruments,
using the Agilent Connection Expert.
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Communicating with a USB Instrument Using VISA
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To establish communications with a USB device using VISA, you can
either use the full VISA resource string for the device or use the alias
provided by VISA. Using the alias is recommended, for reasons
described below.

Using the full VISA resource string, a viOpen call would look
something like this:

viOpen ( .7
"USB0::2391::1031::0000000123::0::INSTR",
);

Following is a summary of the components of this call.

Table 34 Summary of Full-String viOpen Call

Value Description Data Type

2391 Manufacturer 1D 16-bit unsigned integer

1031 Model Code 16-bit unsigned integer

0000000123 Serial Number string value

0 USBTMC Interface 8-bit unsigned integer
Number

This string uniquely identifies the USB device. The values needed for
the resource string are displayed in a dialog box when the device is
plugged into the computer.

To simplify the way a USB device is identified, Agilent VISA also
provides an alias which can be used in place of this resource string. The
first USB device that is plugged in is assigned a default alias of
UsbDevicel. Additional devices are assigned aliases of UsbDevice2,
UsbDevice3, etc. You can modify the default alias name at the time a
device is plugged in, or by running Agilent Connection Expert and
changing the properties of the VISA alias.
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Although the case of a VISA alias is preserved, case is ignored when the
alias is used in place of the full resource string in a viOpen call. For
example, UsbDevicel, usbdevicel and USBDEVICE] all refer to
the same device.

Using the alias, a viOpen call would look something like this:
viOpen( . . ., "UsbDevicel"™, . . . );

As you can see, this is much simpler than having to use the full resource
string for a USB device.

Using the alias in a program also makes it more portable. For example,
two identical USB function generators have different resource strings
because they have different serial numbers. If these function generators
are used in two different test systems and you use the full resource string
to access the function generator in the test program, you cannot use that
same program for both test systems, since the function generators’ full
resource strings are different. By using the alias in the program,
however, you can use the same program in both test systems. All you
need to do is make sure the same alias is used for the function generator
in both systems.

Agilent VISA User’s Guide



Agilent 10 Libraries Suite
Agilent VISA User’s Guide

Glossary

access board

The GPIB interface to which a particular device is connected.

Active Controller

See "Controller in Charge".

address

A string (or other language construct) that uniquely locates and
identifies a resource. VISA defines an ASCII-based grammar that
associates address strings with particular physical devices or
interfaces and VISA resources.

Agilent 488

An I/O library provided in Agilent IO Libraries Suite for
compatibility with existing test & measurement programs that were
developed using National Instruments’ NI-488 or other similar
libraries. Agilent 488 supports communication with GPIB devices
and interfaces, but does not support USB, LAN, RS-232, or VXI
communications.

alias

See VISA alias.

API

Application Programming Interface. The interface that a programmer
sees when creating an application. For example, the VISA API
consists of the sum of all of the operations, attributes, and events of
each of the VISA ResourceClasses.
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attribute

In VISA and SICL, a value that indicates the operational state of a
resource. Some attributes can be changed; others are read-only.

board

A GPIB interface. It may be a physical board, an adapter (such as the
82357 USB/GPIB adapter), or a remote GPIB interface.

board descriptor

A handle, returned from ibfind, that uniquely identifies a GPIB
interface (board) in Agilent 488 original API calls. Also called an
interface descriptor or board unit descriptor.

board-level

Refers to Agilent 488 functions that operate on an interface (board),
rather than on a device.

bus error

An error that signals failure to access an address. Bus errors occur in
conjunction with low-level accesses to memory, and usually involve
hardware with bus mapping capabilities. Bus errors may be caused
by non-existent memory, a non-existent register, an incorrect device
access, etc.

bus error handler

Software that runs when a bus error occurs.

CIC

Controller in Charge.

command bytes

GPIB commands encoded as individual bytes. Also called GPIB
commands or interface messages.
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commander

In test-system architectures, a device that has the ability to control
another device. In a specialized case, a commander may also be the
device that has sole control over another device (as with the VXI
Commander/Servant hierarchy).

commander session

A session that communicates to the interface’s commander.
Commander sessions are used when an interface is in a
non-Controller role.

communication channel

A communication path between a software element and a resource.
In VISA, “communication channel” is synonymous with “session.”
Every communication channel in VISA is unique.

Connection Expert

An Agilent software utility that helps you quickly establish
connections between your instruments and your PC. It also helps you
troubleshoot connectivity problems. Connection Expert is part of the
Agilent 10 Libraries Suite product.

Controller

A device (typically a computer) used to communicate with another
device or devices (typically instruments). The Controller is in charge
of communications and device operation; it controls the flow of
communication and performs addressing and other bus management
functions.

Controller in Charge

The device currently in control of the GPIB.
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device

A unit that receives commands from a Controller. A device is
typically an instrument, but can also be a computer acting in a
non-Controller role or another peripheral such as a printer or plotter.
In VISA, a device is logically represented by the association of
several VISA resources.

device descriptor

A handle, returned from ibdev or ibfind, that uniquely identifies a
device in Agilent 488 original API calls. Also called a device unit
descriptor.

device driver

Software code that communicates with a device: for example, a
printer driver that communicates with a printer from a PC. A device
driver may either communicate directly with a device by reading to
and writing from registers, or it may communicate through an
interface driver.

device session

A session that communicates as a Controller with a single, specific
device such as an instrument.

device-level

Refers to Agilent 488 functions that operate on a device (instrument),
rather than on an interface.

direct I/O

Programmatic communication with instruments not involving an
instrument driver. Direct I/O may be accomplished by using an IO
Library (VISA, VISA COM, SICL, or Agilent 488) or by using
direct I/O tools such as those provided by Agilent VEE and Agilent
T&M Toolkit.

driver

See instrument driver and device driver.
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explorer view

The tree view within the Connection Expert window that shows all
devices connected to a test system.

handler
A software routine that responds to an asynchronous event such as an
SRQ or an interrupt.

instrument
A device that accepts commands and performs a test and
measurement function.

instrument driver
Software that runs on a computer to allow an application to control a
particular instrument.

Interactive 10

An Agilent application that allows you to interactively send
commands to instruments and read the results. Interactive IO is part
of the Agilent IO Libraries Suite product.

interface

A connection and medium of communication between devices and
controllers. Interfaces include mechanical, electrical, and protocol
connections.

interface descriptor

A handle, returned from ibfind, that uniquely identifies a GPIB
interface (board) in Agilent 488 original API calls. Also called a
board descriptor or board unit descriptor.

interface driver

Software that communicates with an interface. The interface driver
also handles commands used to perform communications on an
interface.
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interface messages

GPIB commands encoded as individual bytes. Also called GPIB
commands or command bytes.

interface session

A session that communicates and controls parameters affecting an
entire interface.

interrupt

An asynchronous event that requires attention and actions that are
out of the normal flow of control of a program.

10 Control

The icon in the Windows notification area (usually the lower right
corner of your screen). The 10 Control gives you access to Agilent
I/0 utilities such as Connection Expert, Agilent I/O documentation,
and VISA options.

IO Libraries

Application programming interfaces (APIs) for direct I/O
communication between applications and devices. There are four
Agilent IO Libraries in the Agilent 1O Libraries Suite: VISA, VISA
COM, SICL, and Agilent 488.

Listener

A device that can receive data from the bus when instructed
(addressed to listen) by the System Controller.

lock

A state that prohibits other users from accessing a resource such as a
device or interface.
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logical unit

A number associated with an interface. A logical unit, in SICL and
Agilent VEE, uniquely identifies an interface. Each interface on the
controller must have a unique logical unit.

mapping
An operation that returns a reference to a specified section of an
address space and makes the specified range of addresses accessible
to the requester. This function is independent of memory allocation.
non-Controller role
A computer is in a non-Controller role when it acts as a device
communicating with a computer that is in a Controller role.

notification area

The area on the Windows taskbar where notifications are posted,
typically in the lower right corner of the screen. Also called taskbar
notification area or Windows notification area.

operation

A defined action that can be performed on a resource.

primary VISA

The VISA installation that controls the visa32.dll file. The primary
VISA will be used by default in VISA applications. See also
secondary VISA.

process

An operating system component that shares a system's resources. A
single-process computer system allows only a single program to
execute at any given time. A multi-process computer system allows
multiple programs to execute simultaneously, each in a separate
process environment.
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programming alias

See VISA alias.

refresh

In Connection Expert, the action that invokes the discovery
mechanism for detecting interfaces and instruments connected to
your computer. The explorer view is then refreshed to show the
current, discovered state of your test system.

register

An address location that contains a value that represents the state of
hardware, or that can be written into to cause hardware to perform a
specified action or to enter a specified state.

resource (or resource instance)

In VISA, an implementation of a resource class (in object-oriented
terms, an instance of a resource class). For example, an instrument is
represented by a resource instance.

resource class

The definition of a particular resource type (a class in object-oriented
terms). For example, the VISA Instrument Control resource classes
define how to create a resource to control a particular capability of a
device.

resource descriptor

A string, such as a VISA resource descriptor, that specifies the I/O
address of a device.

SCPI

Standard Commands for Programmable Instrumentation: a standard
set of commands, defined by the SCPI Consortium, to control
programmable test and measurement devices in instrumentation
systems.
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secondary VISA

A VISA installation that does not install visa32.dll in the standard
VISA location. The secondary VISA installation names its VISA
DLL with a different name (agvisa32.dll) so that it can be accessed
programmatically. The primary VISA will be used by default in
VISA applications. See also primary VISA.

session

VISA term for a communication channel. An instance of a
communications path between a software element and a resource.
Every communication channel in VISA is unique.

SICL

Standard Instrument Control Library. SICL is an Agilent-defined
API for instrument I/O. Agilent SICL is one of the IO Libraries
installed with Agilent IO Libraries Suite.

side-by-side

A side-by-side installation allows two vendors' implementations of
VISA to be used on the same computer. See also primary VISA and
secondary VISA.

SRQ

An IEEE-488 Service Request. This is an asynchronous request (an
interrupt) from a remote device that requires service. In GPIB, an
SRQ is implemented by asserting the SRQ line on the GPIB. In VXI,
an SRQ is implemented by sending the Request for Service True
event (REQT).

Standby Controller

A device or interface that has Controller capability, but is not
currently the Active Controller.
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status byte

A byte of information returned from a remote device that shows the
current state and status of the device. If the device follows IEEE-488
(GPIB) conventions, bit 6 of the status byte indicates whether the
device is currently requesting service.

symbolic name

A name corresponding to a single interface. This name uniquely
identifies the interface on this Controller or gateway. When there is
more than one interface on the Controller or gateway, each interface
must have a unique symbolic name.

System Controller

One Controller on a GPIB is the System Controller. This is a master
Controller; it has the ability to demand control and to assert the IFC
(Interface Clear) and REN (remote enable) lines.

system tray

See notification area.

Talker

A device that transmits data onto the bus when instructed (addressed
to talk).

task guide

The information and logic represented in the left pane of the
Connection Expert window. The task guide provides links to actions
and information that help guide you through the most common I/O
configuration tasks.

taskbar notification area

See notification area.

Agilent VISA User’s Guide



Glossary

test system

An entire test setup including a controller (often a PC), instruments,
interfaces, software, and any remote controllers, instruments, and
interfaces that are configured to be used as part of the system.

thread

An operating system object that consists of a flow of control within a
process. A single process may have multiple threads, each having
access to the same data space within the process. Each thread has its
own stack, and all threads may execute concurrently (either on
multiple processors, or by time-sharing a single processor).

ViFind32

A console application that uses the viFindRsrc and viFindNext VISA
functions to enumerate all resources visible to VISA. This
application is useful for verifying that all expected interfaces have
been configured by Connection Expert, and that the expected devices
have been attached. ViFind32 is part of the Agilent IO Libraries
Suite.

virtual instrument

A name given to the grouping of software modules (such as VISA
resources with any associated or required hardware) to give them the
functionality of a traditional stand-alone instrument. Within VISA, a
virtual instrument is the logical grouping of any of the VISA
resources. The VISA Instrument Control Resources Organizer serves
as a means to group any number of any type of VISA Instrument
Control Resources within a VISA system.

VISA

Virtual Instrument Software Architecture. VISA is a standard I/O
library that allows software from different vendors to run together on
the same platform. Agilent VISA is part of the Agilent IO Libraries
Suite.

VISA address

A resource descriptor that can be used to open a VISA session.
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VISA alias

A string that can be used instead of a resource descriptor in VISA
programs. Using VISA aliases rather than hard-coded resource
descriptors makes your programs more portable. You can define
VISA aliases for your instruments in Connection Expert.

VISA COM

The VXIplug&play specification for a COM-compliant VISA 1/O
library and its implementation. Agilent VISA COM is part of the
Agilent IO Libraries Suite.

VISA Instrument Control Resources

The VISA definition of device-specific resource classes. VISA
Instrument Control Resources include all VISA-defined device and
interface capabilities for direct, low-level instrument control.

VISA name
The prefix of a VISA address, also called the VISA interface ID.
The VISA name specifies the interface.

VISA resource manager

The part of VISA that manages resources. This management includes
support for opening, closing, and finding resources, setting attributes,
retrieving attributes, and generating events on resources.

VISA resource template

The part of VISA that defines the basic constraints and interface
definition for the creation and use of a VISA resource. Each VISA
resource must derive its interface from the VISA resource template.

VXI Resource Manager

A software utility that initializes and prepares a VXI system for use.
The VXI Resource Manager is part of the Agilent IO Libraries Suite.
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Windows notification area

See notification area.
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examples

Checking Instrument Errors, 79
Determining Window
Mapping, 126
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Exception Events, 82
Exclusive Lock, 86
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Interface, 98
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MEMACC Resource
Program, 119
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Opening a Resource Session, 33
Opening a Session, 37
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F

field width, 44
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G

GPIB interfaces, introduction, 92
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handlers, 56
event, 66
installing, 65
prototype, 66
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descriptions, 121
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non-formatted I/O
mixing with formatted I/0, 53

0]

opening sessions, 32
overview, guide, 8

Q

queuing and events, 56, 73
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sample code
See also examples
searching for resources, 39
sessions
device, 32
opening, 32
resource manager, 32
SRQs, 56
starting the resource manager, 32

T

timeout, 33, 75
trigger lines, 127
triggers and events, 56
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USB
communicating with instruments
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VISA
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